
University of Louisville University of Louisville 

ThinkIR: The University of Louisville's Institutional Repository ThinkIR: The University of Louisville's Institutional Repository 

Electronic Theses and Dissertations 

5-2018 

Comparing stenotic blood flow in three- and two-dimensional Comparing stenotic blood flow in three- and two-dimensional 

arterial renderings using computational fluid dynamics and arterial renderings using computational fluid dynamics and 

multiphase mean age theory. multiphase mean age theory. 

Jacob S. Garza 
University of Louisville 

Follow this and additional works at: https://ir.library.louisville.edu/etd 

 Part of the Biochemical and Biomolecular Engineering Commons, and the Other Chemical Engineering 

Commons 

Recommended Citation Recommended Citation 
Garza, Jacob S., "Comparing stenotic blood flow in three- and two-dimensional arterial renderings using 
computational fluid dynamics and multiphase mean age theory." (2018). Electronic Theses and 
Dissertations. Paper 2888. 
https://doi.org/10.18297/etd/2888 

This Master's Thesis is brought to you for free and open access by ThinkIR: The University of Louisville's Institutional 
Repository. It has been accepted for inclusion in Electronic Theses and Dissertations by an authorized administrator 
of ThinkIR: The University of Louisville's Institutional Repository. This title appears here courtesy of the author, who 
has retained all other copyrights. For more information, please contact thinkir@louisville.edu. 

https://ir.library.louisville.edu/
https://ir.library.louisville.edu/etd
https://ir.library.louisville.edu/etd?utm_source=ir.library.louisville.edu%2Fetd%2F2888&utm_medium=PDF&utm_campaign=PDFCoverPages
http://network.bepress.com/hgg/discipline/241?utm_source=ir.library.louisville.edu%2Fetd%2F2888&utm_medium=PDF&utm_campaign=PDFCoverPages
http://network.bepress.com/hgg/discipline/250?utm_source=ir.library.louisville.edu%2Fetd%2F2888&utm_medium=PDF&utm_campaign=PDFCoverPages
http://network.bepress.com/hgg/discipline/250?utm_source=ir.library.louisville.edu%2Fetd%2F2888&utm_medium=PDF&utm_campaign=PDFCoverPages
https://doi.org/10.18297/etd/2888
mailto:thinkir@louisville.edu


 
 

COMPARING STENOTIC BLOOD FLOW IN THREE- AND TWO-DIMENSIONAL 
ARTERIAL RENDERINGS USING COMPUTATIONAL FLUID DYNAMICS AND 

MULTIPHASE MEAN AGE THEORY 
 
 
 
 
 
 

By 
 

Jacob S. Garza 
B.S., University of Louisville, 2017 

 
 
 
 
 

A Thesis 
Submitted to the Faculty of the 

University of Louisville 
J. B. Speed School of Engineering 

as Partial Fulfillment of the Requirements 
for the Professional Degree 

 
 
 
 
 

MASTER OF ENGINEERING 
 
 
 
 
 

Department of Chemical Engineering 
 
 
 

May 2018 
 
 
 
 



 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 

ii 
 

 



iii 
 

ACKNOWLEDGEMENTS 

I have to thank Dr. Berson for his constant guidance and assistance through all of 

this. 

I have to also thank Javad, Dr. Shahab, and Elmira for making most of this work 

possible. Our weekly meetings were always beneficial. I have to thank Dr. Willing for 

reviewing my writing and teaching me so much over the years. With this, I would like to 

also thank the other faculty members of the department for greatly furthering my 

education. Also, Dr. Pantalos gets a massive thank you for stepping in on such short 

notice to help as a member of the committee. 

Lastly, my family and friends deserve special attention and recognition for 

supporting me, encouraging me, and improving me throughout this voyage. They ensured 

there was nothing to fear and nothing to doubt. 

 

 

 

 

 

 

 

 

 



iv 
 

TABLE OF CONTENTS 

 Page 
APPROVAL PAGE .......................................................................................................  ii 
ACKNOWLEDGEMENTS ...........................................................................................  iii 
ABSTRACT ...................................................................................................................  vi 
NOMENCLATURE ......................................................................................................  viii 
LIST OF TABLES .........................................................................................................  ix 
LIST OF FIGURES .......................................................................................................  x 
 I.     INTRODUCTION ......................................................................................  1 
 II.     LITERATURE REVIEW ...........................................................................  4 
  A.     Coronary Artery Disease (CAD) ....................................................  4 
   1.     General Information: Pathophysiology and Epidemiology  4 
   2.     Current State of Diagnosis..................................................  6 
  B.     Fractional Flow Reserve (𝐹𝐹𝑅) in Angiography ...........................  9 
   1.     Definition ............................................................................  9 
   2.     Use in ICA and the Extension to Coronary CTA ...............  11 
   3.     Clinical Comparison of 𝐹𝐹𝑅 and 𝐹𝐹𝑅𝐶𝑇 ...........................  13 
  C.     Computational Fluid Dynamics (CFD) ..........................................  15 
   1.     General Information: Conservation and Discretization ......  15 
   2.     Utilization in Multiphase Systems......................................  20 
  D.     Age Topics .....................................................................................  21 
   1.     Residence Time Distributions (RTDs) and Mean Age 
        .     Theory.................................................................................  21 
   2.     Deriving Mean Age Conservation and the Extension to 
        .     Multiphase Systems ............................................................  23 
 III.     EXPERIMENTAL METHODS .................................................................  28 
  A.     Preliminaries ...................................................................................  28 
   1.     Purpose ...............................................................................  28 
   2.     Plan .....................................................................................  28 
  B.     Materials .........................................................................................  29 
  C.     Procedures for Processing Two Orthogonal Arterial Slices ...........  30 
   1.     Geometry Generation .........................................................  30 
   2.     Mesh Generation ................................................................  44 
   3.     Fluent Case Processing .......................................................  51 
 IV.     RESULTS AND DISCUSSION ................................................................  69 
  A.     Scope of Investigated Patient Numbers, Source Renderings, and     
  Created Slices .................................................................................  69 
  B.     Fluent Results of the Three-Dimensional Source Renderings .......  80 
  C.     Fluent Results of the Two-Dimensional Arterial Slices .................  85 
   1.     Plots of Scalar0 Mean Age and Nominal Mean Residence 
        .     Time Comparison ...............................................................  85 
   2.     Plots of Velocity Contours .................................................  91 
  D.     Three- and Two-Dimensional Comparison of Mean Age ..............  97 

 



v 
 

TABLE OF CONTENTS (CONT.) 

 Page 
 V.     CONCLUSIONS ........................................................................................  105 
 VI.     RECOMMENDATIONS ...........................................................................  108 
REFERENCES CITED ..................................................................................................  110 
APPENDIX I. SAMPLE SOURCE CODE FOR A UDF FILE ...........................  113 
APPENDIX II. PLOTS OF SCALAR1 MEAN AGE ...........................................  115 
VITA ..............................................................................................................................  119 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



vi 
 

ABSTRACT 

Over one million invasive coronary angiography procedures are performed 

annually in patients who experience chest pain or are known to have coronary artery 

disease. The procedure is carried out to ascertain the degree of arterial blockage (stenosis) 

that hinders blood flow to the heart. A cardiologist performing the procedure determines 

the physiological degree of a stenosis by either visual estimation, which is routine 

practice, or by invasively measuring fractional flow reserve (𝐹𝐹𝑅), which is the current 

gold standard that has been demonstrated to improve patient outcomes and temper the 

cost of healthcare. Nevertheless, 𝐹𝐹𝑅 is performed in only 10–20% of patients because it 

is invasive, expensive, and requires more radiation exposure. 

New computational methods utilizing three-dimensional renderings processed 

from coronary angiograms can provide an accurate, highly sensitive, non-invasive 

method to assess stenotic significance without using 𝐹𝐹𝑅. While beneficial, this 

technique requires intensive computer processing power and calculation runtimes on the 

order of several hours. An approach to reduce computational time involves alike 

computing of two-dimensional arterial slices cut from the three-dimensional source 

renderings.  

The main objective was to determine if two-dimensional processing can also 

provide an accurate and highly sensitive method to assess stenotic significance at a 

fraction of the computational expense. Blood flow was analyzed in five patient cases 

below and five patient cases above the commonly accepted 𝐹𝐹𝑅 threshold value for 

intervention of 0.80. Following the generation of two orthogonal slices from DICOM-

derived three-dimensional renderings, pulsing blood flow was simulated with CFD, and 
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multiphase mean age theory was applied to calculate the mean age of red blood cells as a 

diagnostic metric. 

Two-dimensional processing typically exhibited a correlation with 𝐹𝐹𝑅 only in 

the geometries of vertically-oriented slices. This was ascribed to the possibility of 

uncaptured stenotic blood flow characteristics in the limited testing of only two angles of 

a full arterial segment. Mean ages for the three-dimensional cases were many orders of 

magnitude higher than those of the corresponding two-dimensional cases. This was 

attributed to red blood cell collisions and distal recirculatory eddies near a stenosis being 

less expressed in the simplicity of the two-dimensional slices when compared to the 

complexity of the three-dimensional source renderings.  

A mean age threshold for determining stent intervention was estimated for the 

two-dimensional cases since limited sample size disallowed rigorous statistical analysis. 

The data suggested an arbitrary value equal to ~2.5. Nine out of ten cases correlated with 

𝐹𝐹𝑅, with just one false negative diagnosis. In published virtual 𝐹𝐹𝑅 techniques, false 

diagnosis typically occurs in 10–13% of the cases. 

Computational runtime for two-dimensional cases was less than 2% of the 

runtime for corresponding three-dimensional cases. Preliminary results indicate two-

dimensional processing may efficiently detect and assess stenoses non-invasively, 

provided that it holds up to rigorous statistical analysis following testing of at least 80–

100 more cases, plus several additional slice angles. 
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NOMENCLATURE 

𝑎 = mean age 
𝑎𝑖, 𝑎1, 𝑎3 = components 𝑖, 1, and 3 of an imparting velocity vector 
𝑏𝑗, 𝑏2, 𝑏4 = components 𝑗, 2, and 4 of an imparting velocity vector 

𝐶 = concentration of a passive scalar 
𝐶(𝑥, 𝑡) = concentration of a passive scalar at a location 𝑥 and time 𝑡 

𝐶𝐹𝑅 = coronary flow reserve 
𝐶𝑜𝑢𝑡 = flow-weighted average concentration across the exit plane 

𝐷 = molecular diffusivity 
𝐷𝑒 = effective turbulent diffusivity 

𝐹𝐹𝑅 = fractional flow reserve 
𝐹𝐹𝑅𝐶𝑇 = fractional flow reserve derived from coronary CTA 

𝑔⃗ = gravitational force per unit mass vector 
𝑖̂ = unit vector in the direction of 𝑖 
𝑗̂ = unit vector in the direction of 𝑗 

𝑛̂ = normal outward vector at the surface 
𝑝 = pressure 

𝑝𝑎 = pressure of an artery proximal to a stenosis 
𝑝𝑑 = pressure of an artery distal to a stenosis 

𝑝𝑜𝑢𝑡𝑙𝑒𝑡 = outlet pressure 
𝑝𝑣 = pressure of associated vein 
𝑅 = resistance 
𝑆 = surface of a control volume 

𝑆𝑚 = source mass added to the continuous phase from the dispersed second 
phase (or any user-defined sources) 

𝑡 = time 
𝑡̅ = mean residence time 
𝑢 = general dependent variable 

𝑢𝑖 = discretized analog of 𝑢 with values of 𝑖 
𝑢𝑖−1 = previous term of the discretized analog of 𝑢 with values of 𝑖 dictated by 

a Taylor series expansion 
𝑣⃗ = total velocity vector 

𝑣𝑖𝑛𝑙𝑒𝑡 = inlet velocity 
𝑥 = general independent variable 

𝑥𝑖 = grid points with values of 𝑖 
𝑥𝑛 = normal coordinate in the direction of flow 

𝑦 = general independent variable 
𝛼(𝑥, 𝑡) = phasic volume fraction of an individual phase at a location 𝑥 and time 𝑡 

𝜹 = unit tensor 
𝜇 = viscosity 
𝜌 = density 
𝝉 = shear stress 

𝜑(𝑥, 𝑡) = passive scalar value at a location 𝑥 and time 𝑡 
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I. INTRODUCTION 

Cardiovascular diseases are a frequent aggressor of health in today’s society, and 

they remain pervasive as a result of easily disregarded risk factors such as poor diet and 

sedentary lifestyles. Coronary artery disease (CAD) is the most prominent type of 

cardiovascular disease, and it is the leading cause of mortality worldwide. CAD signifies 

the existence of inflammatory atherosclerosis affecting the inner wall of coronary arteries 

in an occlusive manner. Directly, plaques may accrete in response to fibrosis and 

calcification, leading to the thickening of the inner wall of arteries and advancing the 

constriction of arterial lumina to cause a stenosis.  

The predominance of cardiovascular diseases such as CAD has generated 

significant interest in the areas of associated risk factor analysis, prevention, and the 

development of uncomplicated diagnosis. Presently, invasive coronary angiography 

(ICA) employs catheterization to obtain a moving picture of the coronary system, but a 

limitation of this utility arises from its incapacity to enumerate the physiological extent of 

stenoses. As a result, the metric of fractional flow reserve (𝐹𝐹𝑅) was developed to assess 

the fraction of maximal blood flow that may be achieved in a stenotic artery by 

invasively measuring a ratio of pressures distal and proximal to a stenosis. A measured 

𝐹𝐹𝑅 value less than 0.80 is the threshold below which a cardiologist intervenes with stent 

placement to prevent ischemia. The invasive determination of 𝐹𝐹𝑅 has risen to represent 

the current gold standard for decision making on stent placement. 

Current research has extended the topic of 𝐹𝐹𝑅 to its use in non-invasive, 

computationally-derived techniques such as coronary computed tomography angiography 

(coronary CTA). Specifically, fractional flow reserve derived from coronary CTA 
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(𝐹𝐹𝑅𝐶𝑇) has emerged to become an innovative and non-invasive technique for evaluation 

of stenoses. 𝐹𝐹𝑅𝐶𝑇 is calculated from hyperemic blood flow simulated in arterial 

renderings using computational fluid dynamics (CFD) to determine the possibility of 

CAD and the extent of stenoses. Its adoption, however, is largely dependent on the 

monumentally challenging prospect of the medical industry’s acceptance of coronary 

CTA as a successor to ICA. 

This thesis investigates a presently competing approach that utilizes CFD and 

multiphase mean age theory to unite angiography with a non-invasive stenotic evaluator. 

Multiphase mean age theory is a concept founded on principles of residence time 

distributions (RTDs) and mean age distributions developed by Danckwerts in the 1950s. 

Mean age distributions overcome the limitation of discrete sampling at the system exit 

typically associated with RTDs, thereby providing full insight into the spatial distribution 

of mixing throughout an entire system volume. Nevertheless, mean age distributions are 

largely impractical to develop experimentally due to the contingency of measuring an 

applied passive tracer throughout an entire system volume. CFD, however, is an ideal 

tool for spatially resolved mixing. Mean age theory and its extension to multiphase 

systems, in conjunction with CFD, redefines time as a passive scalar in the transient 

advection-diffusion equation, allowing conventionally time-based variables to be 

analyzed with a steady-state solution.  

The objectives of the work presented in this thesis were to simulate blood flow 

through arterial renderings, apply multiphase mean age theory using CFD, and compare a 

novel mean age metric determined from two-dimensional arterial slices with those that 

are used to detect and assess a stenotic artery determined from corresponding three-
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dimensional arterial renderings. The most significant outcome if similar results were 

obtained between three- and two-dimensional processing would be reduced 

computational runtime. A shortcoming of CFD processing of three-dimensional flow 

arises from considerably lengthy calculation runtimes. Even with parallel computing on 

up to 20 processors, calculations can approach a total duration on the order of several 

hours to simulate multiphase flow in a typical three-dimensional segment of an artery. 

Simulating flow in a two-dimensional slice of the same segment takes on the order of 

about 60 minutes. 

 With the motivation of the content of this thesis considered, the specific 

objectives are: 

1) generate two-dimensional arterial slices from three-dimensional source 

renderings using computer-aided design software packages; 

2) use multiphase mean age theory in conjunction with CFD modeling to simulate 

blood flow in five two-dimensional cases above and five two-dimensional 

cases below the 0.80 𝐹𝐹𝑅 threshold value; and 

3) compare the mean age metric determined from the two-dimensional arterial 

slices to those determined from the corresponding three-dimensional source 

renderings. 
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II. LITERATURE REVIEW 

A. Coronary Artery Disease (CAD) 

1. General Information: Pathophysiology and Epidemiology 

Coronary artery disease (CAD) is a cardiovascular disease typified by plaque 

buildup in the walls of the arteries that supply blood to the heart and other parts of the 

body. CAD refers to the process of atherosclerosis pathologically affecting coronary 

arteries, and the disease includes a spectrum of consequential diagnoses including angina 

pectoris, myocardial infarction, silent myocardial ischemia, and sudden cardiac death 

(Hanson et al., 2013). CAD may be more descriptively defined as an inflammatory 

disease with lipid and macrophage collection on arterial walls as a result of developing 

atherosclerosis (Sun and Xu, 2014).  

Atherosclerosis is an inflammatory disease of the inner wall of coronary arteries 

that is hastened by the commonly known risk factors of high blood pressure, high 

cholesterol, tobacco use, and diabetes. Atherosclerosis is slowly progressive, however, 

and it silently develops through fibrosis and calcification (Gerber, 2007). The gradual 

accretion of plaques leads to the thickening of the inner wall of arteries, permitting, over 

time, the considerable constriction of arterial lumina (Ambrose and Singh, 2015). 

Defined as stenosis, the narrowing of arterial passageways is the foundational point of 

concern for CAD and its resultant diagnoses. When plaques hinder a coronary lumen and 

create a stenosis, blood flow is obstructed, occasionally establishing stable angina 

pectoris, a condition characterized by discomfort and pain in the chest. In other cases, the 

initiation of platelets and blood coagulation factors may occur if the thinned endothelium 

covering non-occlusive, lipid-rich plaques unexpectedly ruptures and exposes thrombotic 
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components to blood (Gerber, 2007). As a result, coronary lumen occlusion may occur, 

instigating ischemia and imparting the substantially more critical issues of unstable 

angina pectoris, myocardial infarction, silent myocardial ischemia, or sudden cardiac 

death. 

Since CAD develops slowly, strikes unexpectedly, and proliferates through easily 

unheeded risk factors (e.g., poor diet and sedentary lifestyles), it is predictably the 

leading cause of death worldwide (Finegold et al., 2012), and it is responsible for nearly 

7.3 million annual deaths and 58 million disability-adjusted life years lost worldwide 

(Sun and Xu, 2014). In the United States, CAD is estimated to affect 16.8 million people 

alone (Cassar et al., 2009). With this, an American will have a coronary-related event 

approximately every 25 seconds, and someone will die of one every minute (Hanson et 

al., 2013). While CAD is the leading cause of morbidity and mortality in advanced 

countries, its pervasiveness is amply rising in developing countries as well (Sun and Xu, 

2014). This is attributable to the broader issue of cardiovascular disease becoming 

widespread as developing countries transition epidemiologically from pestilence and 

famine to pandemics and progressive diseases (Cassar et al., 2009). In 2002, out of a 

worldwide total of 57 million deaths, around 17 million were due to cardiovascular 

disease, and CAD was responsible for nearly half of these cardiovascular deaths (Cassar 

et al., 2009). While high income countries have recently seen declines in deaths from 

CAD, continued high CAD mortality is persistent elsewhere (Finegold et al., 2012), with 

the mortality rate from cardiovascular disease predicted to reach 23.4 million in 2030 

(Cassar et al., 2009).  
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2. Current State of Diagnosis 

The predominance of CAD has sparked widespread interest in risk factor analysis, 

prevention, and the development of uncomplicated diagnosis. While risk factors may be 

moderated by proper diet and lifestyle, testing, when needed, is sought to become 

uncomplicated and non-invasive in pursuance of enabling routine checkup and fulfilling 

time-sensitive constraints incumbent upon the disease. The tests currently available for 

CAD differ in modality and utility, and they serve to stand in comparison to the gold 

standard of invasive coronary angiography. The following list from Hanson et al. (2013) 

summarizes the current state of available tests for CAD diagnosis: 

a. Electrocardiography (ECG).  ECG is the most common test for CAD, and it 

serves to map the heart rate rhythm over a duration of time. ECG may show 

changes in electrical activity that designate ischemia or indicate previous 

complications of mild myocardial infarction. Despite this, ECG is inadequate 

for full diagnosis since some patients with CAD may produce ordinary results 

if the heart is not under any stress. 

b. Stress Test.  Stress tests involve heart evaluation during concentrated exercise 

usually on a treadmill. Since some signs of CAD may only surface if the heart 

is under exertion, ECG and blood pressure monitoring are utilized in parallel 

while a patient exercises. A patient may experience angina pectoris, and 

possible changes in electrical activity or blood pressure could designate 

ischemia. During the test, patients may also face exertional hypotension or 

hypertension. Exertional hypotension occurs when the blood pressure decreases 

to values lower than the resting systolic pressure, and it regularly signifies 

severe heart failure or multivessel CAD. With this, exertional hypertension may 



 

7 
 

also arise, but it is usually not as troublesome as exertional hypotension and is 

simply evidence of long-term high blood pressure. 

c. Myocardial Perfusion Imaging.  Myocardial perfusion imaging utilizes 

radioactive tracers such as thallium and sestamibi to show how well blood 

perfuses several areas of the heart. These tests are typically performed with a 

stress test. The radioactive substance is injected intravenously, and a special 

camera takes images around the heart. Typical myocardium receives more 

thallium/sestamibi than myocardium being supplied by an occlusive coronary 

artery, so this test can provide partial evidence to the extent of possible CAD. 

d. Coronary Artery Calcium Computed Tomography (CT). Coronary artery 

calcium CT exploits the presence of calcium-rich components in the plaques 

created by atherosclerosis. A cardiac CT scan may be performed and placed in 

context of measured levels of calcium deposits. The supposition is that there is 

a higher chance of CAD if there is a considerable sum of measured calcium. 

The Agatston score quantifies the extent of coronary artery calcification, and it 

is ultimately used to strengthen claims of CAD diagnosis. 

e. Coronary Computed Tomography Angiography (CTA).  Coronary CTA scans 

the coronary arteries following the intravenous injection of a radioactive 

substance. An X-ray source is used to irradiate the area of pertinence to permit 

scans and images of the coronary arteries. Using computer software, algorithms 

may construct three-dimensional arterial renderings by linking images together. 

As a result, the capacity of coronary occlusion may be seen visually, enabling 

informed judgments on CAD diagnosis. 
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f. Invasive Coronary Angiography (ICA).  Invasive coronary angiography is the 

gold standard for CAD diagnosis due to its effectiveness. For this test, a 

catheter is threaded to the heart by initial insertion into vessels through the 

groin, arm, or neck. The heart receives an injection of a radioactive substance 

while angiographs are continually acquired. As a result, a moving picture of the 

coronary system is obtained, providing specific information about the valves 

and arterial function. Important details such as wall motion abnormalities and 

left ventricle ejection fraction may be easily evaluated from the angiograms to 

provide supportive consensus of CAD diagnosis. 

The current state of available tests for CAD diagnosis may be tabulated with additional 

metrics. Hanson et al. (2013) provide the comparison of test sensitivity, specificity, 

advantages, and disadvantages shown in TABLE 2.1: 

TABLE 2.1 

A COMPARISON OF TESTS USED FOR CAD DIAGNOSIS 

Test sensitivity and specificity refer, respectively, to the ability of a test to correctly 

identify those with the disease and the ability of the test to correctly identify those 

Test Sensitivity [%] Specificity [%] Advantages Disadvantages 
ECG 68 97 Inexpensive – 

Stress Test Females: 31–33 
Males: 68 

Females: 52–76 
Males: 77 

Well validated, 
inexpensive, 

readily available 

Less useful for 
those with atypical 
CAD presentation 

Myocardial 
Perfusion Imaging 90 70 High sensitivity Expensive 

Coronary Artery 
Calcium CT 91 46 

Adds prognostic 
value to 

intermediate risk 
group 

Low specificity 

Coronary CTA 94 82 Non-invasive 
New modality, 

expensive, 
radiation exposure  

ICA – – Gold standard 
Invasive, 

expensive, 
radiation exposure 
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without the disease. Using these metrics, the two angiographic techniques shown in 

TABLE 2.1 represent the best methods of examination yet simply differ in procedural 

ideation and execution. 

B. Fractional Flow Reserve (𝐹𝐹𝑅) in Angiography 

1. Definition 

While coronary angiographic techniques represent the preferred forms of 

diagnostics, a shortcoming of their value stems from their inability to characterize the 

physiological magnitude of stenoses. For hearts with normal myocardium and arteries, 

blood flow may increase three to five times in response to hyperemia induced by 

temporary occlusion (Lederman et al., 1997). For hearts with normal myocardium and a 

stenosis, the hyperemic myocardial flow gradually dampens with increasing percentages 

of stenosis, beginning at about 50% (Lederman et al., 1997). At that percentage, a 

stenosis is considered to impede full flow capability, thereby substantiating physiological 

impact. Importantly, angiographic techniques are unreliable in predicting functional flow 

consequences of a stenosis, meaning other approaches must be applied to further develop 

the physiological merit of angiographic diagnoses of CAD. 

Various methods have been used in an attempt to physiologically assess coronary 

stenoses, but the concept of fractional flow reserve (𝐹𝐹𝑅) has gained the most attention 

for clinical utility due to its emergence as a quick and accurate physiological appraisal 

technique (Lederman et al., 1997). 𝐹𝐹𝑅 is defined as the ratio of flow across a stenosis to 

putative flow in the absence of stenosis (Nørgaard et al., 2015). As a result, 𝐹𝐹𝑅 

enumerates the fraction of maximal blood flow that may be achieved in a stenotic artery. 
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Pijls et al. (1996) utilized the research on coronary flow reserve (𝐶𝐹𝑅) from 

Gould et al. (1974) to develop a model using translational pressure gradients to 

mathematically describe 𝐹𝐹𝑅. While 𝐶𝐹𝑅 is similar in its definition to 𝐹𝐹𝑅, its gauging 

relies on direct flow measurement. Pijls et al. (1996) overcame direct flow measurement 

reliance by modifying Poiseuille’s law, permitting the establishment of the concept of 

𝐹𝐹𝑅. Under Poiseuille’s law, the volumetric flow rate of a fluid is proportional to the 

pressure drop across the associated zone of interest and inversely proportional to flow 

resistance in that same zone. As such, the pressure drop across the resistance governs the 

volumetric flow rate through a resistant artery (Lederman et al., 1997). Supposing the 

myocardium is supplied by an artery with a stenosis, the pressure drop is obtained by 

subtracting the venous pressure from the pressure distal to the stenosis (i.e., 𝑝𝑑 − 𝑝𝑣) 

(Lederman et al., 1997). With this, supposing the same artery were not stenotic, the 

pressure drop calculation shifts to a difference in arterial and venous pressures (i.e., 𝑝𝑎 −

𝑝𝑣) (Lederman et al., 1997). Volumetric flow rates are obtained by dividing each pressure 

drop by resistance 𝑅, and a ratio of these volumetric flow rates gives: 

 𝐹𝐹𝑅 = (𝑝𝑑−𝑝𝑣)/𝑅
(𝑝𝑎−𝑝𝑣)/𝑅 = 𝑝𝑑−𝑝𝑣

𝑝𝑎−𝑝𝑣
 (2.1) 

If, as in many circumstances, venous pressure is not elevated, Lederman et al. (1997) 

suggest 𝑝𝑣 may be excluded to give a simpler ratio: 

 𝐹𝐹𝑅 = 𝑝𝑑
𝑝𝑎

 (2.2) 

For normal arteries, 𝐹𝐹𝑅 is unity since 𝑝𝑑 equals 𝑝𝑎. For stenotic arteries, however, the 

pressure drop increases as occlusion increases, meaning 𝑝𝑑 and 𝐹𝐹𝑅 decrease. 
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2. Use in ICA and the Extension to Coronary CTA 

The use of 𝐹𝐹𝑅 in ICA procedures represents the current gold standard for 

determining whether an arterial stenosis causes ischemia (Min et al., 2015). 𝐹𝐹𝑅 

calculation begins with the induction of hyperemia with intravenous adenosine to collect 

physiological data on the flow resistance a stenosis is causing (Lederman et al., 1997). 

Using a catheter, a sensor collects the required pressures at the necessary locations across 

the suspected stenosis, calculating a value of 𝐹𝐹𝑅. An 𝐹𝐹𝑅 less than or equal to 0.80 is 

usually recognized as the limit below which a stenosis is considered to cause ischemia 

(Min et al., 2015). Knowing this threshold value, clinical strategies regarding subsequent 

procedural actions may be targeted appropriately. Specifically, coronary intervention may 

be safely deferred for vessels with an 𝐹𝐹𝑅 greater than 0.80, while coronary 

revascularization is recommended for vessels with a measured 𝐹𝐹𝑅 less than or equal to 

0.80 (Min et al., 2015). In establishing a decisive threshold value of 𝐹𝐹𝑅, improved 

clinical outcomes and reduced costs have been seen when compared to an ICA only, non-

𝐹𝐹𝑅 examination (Min et al., 2015). Ultimately, the addition of the physiological 

component of 𝐹𝐹𝑅 to ICA’s anatomically-based evaluations of stenosis severity facilitate 

proper coronary actions that are enduring and cost-effective (Min et al., 2012). As of yet, 

however, this methodology unifying physiological and anatomical components has not 

been available through non-invasive techniques. 

In an attempt to establish a non-invasive test that quantifies both coronary stenosis 

severity and the associated ischemia, research has increased in the topic of 𝐹𝐹𝑅 to extend 

its use in non-invasive coronary CTA. As a result, fractional flow reserve derived from 

coronary CTA (𝐹𝐹𝑅𝐶𝑇) has emerged to become an innovative and non-invasive method 
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for precise analysis of coronary ischemia caused by a stenosis. 𝐹𝐹𝑅𝐶𝑇 utilizes 

computational fluid dynamics (CFD) to assess the physiological extent of CAD. 

Importantly, CFD may be used to calculate a value of 𝐹𝐹𝑅𝐶𝑇 from previously acquired 

coronary CTA images without the need for further tomographic steps (Min et al., 2015). 

Computing 𝐹𝐹𝑅𝐶𝑇 from coronary CTA images necessitates the generation of a 

physiological model of coronary blood flow, and Nørgaard et al. (2015) describe the 

principles on which the model is established. Specifically, the first principle maintains 

that the sum of resting coronary blood flow may be computed relative to the mass of 

myocardium assessed by CT. The second principle asserts that the resting vascular 

resistance is inversely proportional to the size of the coronary arteries supplying the 

myocardium. Finally, the third principle states that the vasodilatory response to adenosine 

introduction is predictable, allowing computational modeling of hyperemia. With these 

principles established, Min et al. (2015) outline the five required steps for 𝐹𝐹𝑅𝐶𝑇 

calculation:  

1) create patient-specific anatomical models from coronary CTA; 

2) quantify the coronary artery flow in the hypothetical case in which the 

supplying vessels are normal; 

3) determine the baseline resistance for the arteries supplying the myocardium; 

4) quantify the changes in coronary resistance as a result of hyperemia; and 

5) apply CFD methods for calculation of coronary flow, pressure, and velocity at 

hyperemia. 

The grouping of the principles into three-dimensional computational models and the 

execution of the five steps permit the calculation of metrics at every point in the coronary 
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system under normal and hyperemic conditions. In doing so, 𝐹𝐹𝑅𝐶𝑇 is thusly determined 

in an analogous manner to its invasive form in ICA. 

The utilization of CFD to evaluate coronary CTA images enables the computation 

of arterial blood flow and the calculation of stenosis-specific 𝐹𝐹𝑅𝐶𝑇 without the need for 

an invasive procedure. This is to say the computation of 𝐹𝐹𝑅𝐶𝑇 enables the identification 

of patients with physiologically significant stenoses prior to invasive cardiac 

catheterization. Moreover, the utility of 𝐹𝐹𝑅𝐶𝑇 is underscored by its investigative 

potential in modeling innocuous revascularization procedures. Kim et al. (2014) show 

that the same CFD technology could be used to modify stenoses of existing flow models 

to visualize virtual stenting of a pertinent coronary area. In doing so, coronary blood flow 

and 𝐹𝐹𝑅𝐶𝑇 could be recalculated from the new model and be used to validate the 

circulatory effect of the stent on a stenosis-specific basis. Ultimately, the prediction of 

revascularization benefit via virtual approaches extends the continual non-invasive value 

of coronary CTA and its associated 𝐹𝐹𝑅𝐶𝑇. 

3. Clinical Comparison of 𝐹𝐹𝑅 and 𝐹𝐹𝑅𝐶𝑇 

While 𝐹𝐹𝑅𝐶𝑇 calculation is proven beneficial with regards to characterizing 

arterial blood flow and identifying physiologically significant coronary stenoses, its 

comparison to 𝐹𝐹𝑅 from a clinical perspective is principal in efficacy and applicability 

determination. Since its incipience of viability within the past decade, 𝐹𝐹𝑅𝐶𝑇 has gained 

clinical evidence that may be compared to the diagnostic performance of an invasive 

𝐹𝐹𝑅 reference standard (Min et al., 2015). Using a blinded comparison of 𝐹𝐹𝑅𝐶𝑇 to 

𝐹𝐹𝑅, trials involving over 600 patients and 1000 vessels assessing the diagnostic 

functionality of 𝐹𝐹𝑅𝐶𝑇 in recognizing ischemia caused by stenosis in CAD-related 
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instances have been executed (Nørgaard et al., 2015). Using prospective designs with 

demarcations of obstructive CAD at stenoses greater than 50% and ischemia at 𝐹𝐹𝑅 or 

𝐹𝐹𝑅𝐶𝑇 values less than or equal to 0.80, Nørgaard et al. (2015) provide the comparison of 

design, population, test accuracy, sensitivity, and specificity of the studies shown in 

TABLE 2.2: 

TABLE 2.2 

STUDIES COMPARING 𝐹𝐹𝑅𝐶𝑇 DIAGNOSTIC PERFORMANCE USING 𝐹𝐹𝑅 AS 

THE REFERENCE STANDARD 

Study Design Population Accuracy 
[%] 

Sensitivity 
[%] 

Specificity 
[%] 

DISCOVER-
FLOW 

Statistically 
powered on a 

per-vessel 
basis, 

4 centers 

x Patients with suspected or 
known CAD who underwent 
coronary CTA, ICA, and 
𝐹𝐹𝑅. All patients had at least 
one stenosis ≥ 50% in a 
major vessel at coronary 
CTA. 

x 103 patients (159 vessels) 
x Mean age: 63 years 
x 26% female, 74% male 
x Proportion of vessels with 

𝐹𝐹𝑅 ≤ 0.80: 56% 

84 88 82 

De-FACTO 

Statistically 
powered on a 

per-patient 
basis, 

17 centers 

x Patients with suspected or 
known CAD who underwent 
clinically indicated non-
emergent ICA after coronary 
CTA (< 60 days), and with at 
least one ICA stenosis 30–
90% 

x 252 patients (408 vessels) 
x Mean age: 63 years 
x 29% female, 71% male 
x Proportion of patients with 

𝐹𝐹𝑅 ≤ 0.80: 53 % 

73 90 54 

NXT 

Statistically 
powered on a 

per-patient 
basis, 

10 centers 

x Patients suspected of CAD 
who underwent coronary 
CTA and ICA within < 60 
days 

x 254 patients (484 vessels) 
x Mean age: 64 years 
x 36% female, 64% male 
x Proportion of patients with 

𝐹𝐹𝑅 ≤ 0.80: 32 % 

81 86 79 
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The values listed in TABLE 2.2 represent per-vessel and per-patient diagnostic metrics 

for 𝐹𝐹𝑅𝐶𝑇 all greater than or equal to respective percentages for coronary CTA alone. 

For example, Nørgaard et al. (2015) report that the DISCOVER-FLOW study was 

concluded by obtaining per-vessel diagnostic accuracy of 84% for 𝐹𝐹𝑅𝐶𝑇 compared to 

59% for coronary CTA alone, and this arose by specificity increasing from 40% for 

coronary CTA alone to 82% for 𝐹𝐹𝑅𝐶𝑇. This shows the aptitude of 𝐹𝐹𝑅𝐶𝑇 in diagnosing 

CAD when compared to using coronary CTA on its own. With this, Nørgaard et al. 

(2015) also report an increased capacity to discern ischemia on a per-vessel and per-

patient basis. This is due to consistent increases in respective area under receiver 

operating characteristics curves—a measure of how well a parameter can distinguish 

between two diagnostic groups (i.e., having and not having ischemia)—for each 

percentage entry in TABLE 2.2. As a result, 𝐹𝐹𝑅𝐶𝑇 derived from coronary CTA images 

using 𝐹𝐹𝑅 as the reference standard provides high diagnostic performance in patients 

with supposed CAD, thereby encouraging its use as an efficacious tool capable of 

delivering increased analytical sensitivity for anatomical evaluation of the disease and 

high specificity for physiological detection of accompanying ischemia. Ultimately, 

however, the widespread adoption of 𝐹𝐹𝑅𝐶𝑇 is dependent on the exigent prospect of the 

medical industry accepting coronary CTA as a successor to ICA. 

C. Computational Fluid Dynamics (CFD) 

1. General Information: Conservation and Discretization 

Computational fluid dynamics (CFD) is a segment of fluid mechanics that solves 

fluid flow problems by employing numerical methods and data processing techniques. 

CFD is based on transport phenomena, where the conservations of mass, momentum, and 
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energy are of distinct importance. CFD programs offer the ability to solve these otherwise 

impractical conservation equations effectively and simultaneously. By solving the 

conservation equations using a discretized version of a geometric domain, ANSYS 

programs such as Fluent and CFX can simulate fluid flow and calculate relevant fluid 

metrics of user-based preference. In general, these programs have become ubiquitous in 

modeling, permitting the simulation of flow, heat transfer, and reactions for industrial 

applications—ranging from air flow over an aircraft wing to combustion in a furnace, 

from bubble columns to oil platforms, and from blood flow to wastewater treatment 

plants (Software: CFD Simulation, 2017). 

The combination of governing conservation equations used to solve CFD cases 

depend on the individual system to be modeled. While the equation for energy 

conservation is only necessary for problems involving energy transfer, all systems must 

solve the conservation equations of mass and momentum. For the conservation equation 

of mass, continuity is described by: 

 𝜕𝜌
𝜕𝑡 + (∇ ⋅ 𝜌𝑣⃗) = 𝑆𝑚 (2.3) 

The conservation equation of momentum is: 

 𝜕
𝜕𝑡 (𝜌𝑣⃗) + ∇ ⋅ 𝜌𝑣⃗𝑣⃗ = −∇𝑝 − [∇ ⋅ 𝝉] + 𝜌𝑔⃗ (2.4) 

The viscous momentum flux tensor 𝝉 represents shear stress and is given by: 

 𝝉 = −𝜇[∇𝑣⃗ + (∇𝑣⃗)𝑇] + 2
3 𝜇(∇ ⋅ 𝑣⃗)𝜹 (2.5) 

Assuming constant fluid density and viscosity, substitution of 𝝉 in the conservation 

equation of momentum and rearrangement gives the Navier-Stokes equation: 
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 𝜌 (𝜕𝑣⃗⃗
𝜕𝑡 + 𝑣⃗ ⋅ ∇𝑣⃗) = −∇𝑝 + 𝜇∇2𝑣⃗ + 𝜌𝑔⃗ (2.6) 

The conservation of mass and Navier-Stokes equations are solved in CFD 

software by approximating the continuous variables in the partial differentials by discrete 

analogs and utilizing a discretized domain of a geometric mesh or grid. While continuous 

domains have flow variables defined at every point on the domain, discrete ones have 

flow variables defined only at the grid nodes. If each node interacts with adjacent nodes 

predictably, an accurate solution may be obtained. If the grid resolution (i.e., mesh count) 

is sufficient, discretized results approach analytical ones. 

The simplest technique of discretization comes from the finite-difference method. 

For illustration of this method, Bhaskaran and Collins (2002) utilize a linear one-

dimensional differential equation: 

 𝑑𝑢
𝑑𝑥 + 𝑢 = 0; 0 ≤ 𝑥 ≤ 1; 𝑢(0) = 1 (2.7) 

The domain may be discretized into equally-spaced points on a grid, with general grid 

points labeled 𝑥𝑖. Since the governing equation is valid for all 𝑥𝑖, the discretized form of 

Equation (2.7) is: 

 (𝑑𝑢
𝑑𝑥)

𝑖
+ 𝑢𝑖 = 0 (2.8) 

To get an equation for the differential term in terms of 𝑢 at the grid points, a Taylor series 

expansion may be used to give: 

 (𝑑𝑢
𝑑𝑥)

𝑖
= 𝑢𝑖−𝑢𝑖−1

∆𝑥 + 𝑂(∆𝑥) (2.9) 

Excluding higher-order terms in the Taylor series, an algebraic equation is produced: 
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 𝑢𝑖−𝑢𝑖−1
∆𝑥 + 𝑢𝑖 = 0 (2.10) 

While the finite-difference method is simple, it illustrates the foundational discretization 

process. An extension to this technique that Fluent coding uses is the finite-volume 

method. In this method, integral forms of the conservation equations are applied to a cell 

of control volume to obtain discrete equations for each cell. The adjacency of control 

volumes creates a network of cells (i.e., a mesh), and the cells may be represented by a 

wide range of geometries, including those of quadrilaterals, triangles, hexahedra, 

tetrahedra, or prisms. An example of this method is illustrated by the integral form of the 

conservation equation of mass: 

 ∫ (𝑣⃗ ⋅ 𝑛̂)𝑑𝑆 = 0𝑆  (2.11) 

Using an example square cell of length ∆𝑥, height ∆𝑦, and an imparting velocity vector 

of 𝑎𝑖𝑖̂ + 𝑏𝑖𝑗,̂ the discretized form of the integral equation is: 

 −𝑎1∆𝑦 − 𝑏2∆𝑥 + 𝑎3∆𝑦 + 𝑏4∆𝑥 = 0 (2.12) 

Markedly, this equation sums the net mass flow into the control volume of the example 

square cell and sets it equal to zero. By similar treatment, discrete equations for 

remaining conservation equations for the cell may be achieved. Moreover, the finite-

volume method is readily extendable to any other general cell shapes in two or three 

dimensions. 

After discretization, equations are solved simultaneously and iteratively. Fluent 

permits choices between pressure-based and density-based solvers for iteration. 

Historically speaking, the pressure-based approach was developed for low-speed 

incompressible flows, while the density-based approach was mainly used for high-speed 
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compressible flows (Overview of Flow Solvers, 2009). Recently, however, both methods 

have been extended to solve and operate for a wide range of flow conditions beyond their 

traditional intent. In both methods, the velocity field is obtained from the conservation of 

momentum equation. For the pressure-based solver, the pressure field is extracted by 

solving a pressure equation obtained by manipulating conservation of mass and 

momentum equations. In the density-based approach, the conservation of mass equation 

is used to obtain the density field while the pressure field is determined from the equation 

of state. Several steps in the chosen iteration scheme must occur to advance the system to 

solution convergence. The two approaches of iteration schemes and the steps used to 

solve fluid flow problems are shown in FIGURE 2.1: 

 

FIGURE 2.1 - Iteration Schemes for the (a) Pressure-based and (b) Density-based Solvers 

(Overview of Flow Solvers, 2009) 

(b) (a) 
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Importantly, regardless of the solver used, convergence is checked by evaluating how 

much fluid properties have changed from the previous iteration to the current one. If the 

change (i.e., residual) is sufficiently small, the solution is converged. If not, the fluid 

properties are used as initial values for the next iteration, and the scheme repeats. 

2. Utilization in Multiphase Systems 

 Recent advances in CFD have provided the basis for mathematically modeling the 

dynamics of multiphase systems. These systems are characterized by coexisting flow of 

materials with different phases (e.g., a liquid-gas system) or materials with differing 

chemical properties in the same phase (e.g., a water-oil system). The Euler-Lagrange and 

Euler-Euler methods are the two current approaches used for modeling these multiphase 

systems. The Euler-Lagrange approach treats the fluid phase as a continuum by solving 

the time-averaged Navier-Stokes equations and solves the dispersed phase by tracking 

many particles, bubbles, or droplets through the calculated flow field (Overview, 2006). 

While the dispersed phase can exchange momentum, mass, and energy with the fluid 

phase, the Euler-Lagrange approach relies on the fundamental assumption that the 

dispersed phase occupies a low volume fraction. The particle, bubble, or droplet 

trajectories are computed individually at specified intervals during the fluid phase 

calculation, meaning intensive computational processing requirements are needed. 

 The Euler-Euler approach is dissimilar by its treatment of both phases as 

interpenetrating continua (Approaches to Multiphase Modeling, 2006). Since both phases 

are considered continuous, the concept of phasic volume fraction is used. These volume 

fractions are assumed to be continuous functions of space and time and their sum equal to 

one. Conservation equations for each phase are implemented to obtain a set of similarly 
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structured equations for all phases. In Fluent, three different Euler-Euler multiphase 

models are available: volume of fluid, mixture, and Eulerian.  

The volume of fluid method is a surface-tracking technique applied to a fixed 

Eulerian mesh (Approaches to Multiphase Modeling, 2006). It is used for two or more 

immiscible fluids, with the interface between the fluids being of most interest. In this 

model, the fluids share a single set of momentum equations, and the volume fraction of 

each of the fluids in each discretized cell is tracked across the domain. Applications of 

the volume of fluid method include the modeling of spray dryers and coal and liquid fuel 

combustion. Alternatively, the mixture model solves for the mixture momentum equation 

and assigns relative velocities to describe the dispersed phases, making it appropriate for 

modeling systems of sedimentation or cyclone operators that are rich with particles. 

Finally, the Eulerian model is the most complex of the multiphase models in Fluent, and 

it solves a large set of continuity and momentum equations for each phase and couples 

the pressure and interphase exchange coefficients as a way to link solutions for each 

phase (Approaches to Multiphase Modeling, 2006). Momentum exchange between the 

phases is dependent upon the type of mixture being modeled (e.g., granular or non-

granular). Fluent's user-defined functions permit customization of the calculation of 

momentum exchange. Applications of the Eulerian method include bubble columns and 

arterial blood flow. 

D. Age Topics 

1. Residence Time Distributions (RTDs) and Mean Age Theory 

Extensive analysis of residence time distribution (RTD) and age concepts began 

in the 1950s with Danckwerts. Before his research, the ideal mixing absolutes of none 
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(i.e., plug flow) or perfect (i.e., CSTR) were only considered and characterized, leaving a 

void in portraying real processes between these extrema. In 1953, Danckwerts modeled 

non-ideal mixing by measuring the residence time of fluid elements spent inside a 

system. Defining RTD, it is specifically a probability distribution function that expresses 

the amount of time a fluid element could spend inside a system, providing partial insight 

into non-ideal system mixing and dispersion properties. Danckwerts studied the 

probability distribution functions in a variety of vessel types and piping, establishing 

RTDs to be an operative quantifier of non-ideal mixing in real systems. While useful, a 

drawback to RTDs is that the produced function is typically limited to discrete sampling 

at the system exit, thus incognizant of characterizing internal happenings (Russ and 

Berson, 2016). In effect, an RTD provides no information regarding the spatial 

distribution of mixing along the length of a system. While the shape of the produced RTD 

function may imply the presence of dead zones in the mixing system, the location of such 

vessel areas cannot be determined from an RTD (Liu and Tilton, 2010). This prompts the 

desire to understand the spatial distribution of mixing beyond the area of exit and more 

internally.  

In hopes of extending the topic, Danckwerts reclassified the term “residence time” 

for molecules exiting the system as a way to describe the elapsed time since they entered 

and developed the concept of “age” to describe the elapsed time since entrance of 

molecules still in the system (Liu and Tilton, 2010). Consequently, when a molecule 

reaches the exit, its age equals the residence time. As suggested, complete spatial 

distributions of age are most valuable, but they are generally unfeasible to develop 

experimentally since measurement is required across an entire system volume and 
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necessitate tracking the movement of a passive tracer (Russ and Berson, 2016). As a 

solution, in recent years, the application of mean age theory has provided an innovative 

approach in research associated with spatially resolved mixing. Mean age theory permits 

redefining time as a passive scalar in the transient advection-diffusion equation, 

facilitating analysis of traditionally time-based variables (e.g., mean residence time) 

while using a steady-state solution (Russ and Berson, 2016). Passive scalars may be 

thought of as virtual tracers that do not impact flow but are transported by the system as a 

way to track flow. While mean age theory was originally proposed by Danckwerts in 

1958, technological restraints withheld the topic as strictly theoretical. With the rise of 

computational fluid dynamics (CFD), however, spatially resolved solutions for mean age 

theory purposes are now possible. While conventional solutions to the advection-

diffusion equation require a time-demanding transient solution for modeling the time-

dependent tracer behavior, CFD provides robust computing of the transient solution and 

the ability to report spatial and temporal resolution within the flow field (Russ and 

Berson, 2016). 

2. Deriving Mean Age Conservation and the Extension to Multiphase Systems 

Mean age theory as an approach to modeling the time-dependent behavior of a 

passive scalar in steady-state CFD simulations has been used to determine the mean age 

conservation equation plentifully in literature for a single-phase system (Liu and Tilton, 

2010; Sandberg, 1981; Spalding, 1958). Russ and Berson (2016) extend the theory for 

multiphase systems by defining the passive scalar concentration independently for 

individual phases, permitting mean age to be solved at steady-state for each phase 

independently within a multiphase system. Liu and Tilton (2010) begin their derivation 
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by defining a spatially resolved concentration 𝐶(𝑥, 𝑡) for the passive scalar at a location 𝑥 

and time 𝑡. This concentration function is limited in utility for application, so Russ and 

Berson (2016) extend the definition by assuming: 

 𝐶(𝑥, 𝑡) = 𝜌𝜑(𝑥, 𝑡) (2.13) 

Here, 𝜌 is the density of the single phase and 𝜑(𝑥, 𝑡) is the passive scalar value at a 

location 𝑥 and time 𝑡. It follows that the concentration of a passive scalar value for an 

individual phase in a multiphase system is: 

 𝐶(𝑥, 𝑡) = 𝜌𝜑(𝑥, 𝑡)𝛼(𝑥, 𝑡) (2.14) 

Now, 𝜌 is the density of an individual phase and 𝛼(𝑥, 𝑡) is the phasic volume fraction of 

an individual phase at a location 𝑥 and time 𝑡. Using these definitions of passive scalar 

concentration, the derivation for the mean age conservation equation follows directly 

from Liu and Tilton (2010). 

 Mean residence time for either definition of passive scalar concentration may be 

defined as: 

 𝑡̅ = ∫ 𝑡𝐶𝑜𝑢𝑡𝑑𝑡∞
0
∫ 𝐶𝑜𝑢𝑡𝑑𝑡∞

0
 (2.15) 

This may then be extended for the spatial distribution of internal happenings by defining 

mean age as: 

 𝑎 = ∫ 𝑡𝐶(𝑥,𝑡)𝑑𝑡∞
0
∫ 𝐶(𝑥,𝑡)𝑑𝑡∞

0
 (2.16) 

To solve the mean age equation, the transient passive scalar advection-diffusion equation 

is used: 
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 𝜕𝐶
𝜕𝑡 + ∇ ⋅ (𝑣⃗𝐶) = ∇ ⋅ (𝐷∇𝐶) (2.17) 

In this equation, 𝐷 is the molecular diffusivity. Equation (2.17) and the remaining 

derivation steps apply to laminar flow systems. In the case of turbulent flow systems, 

Equation (2.17) becomes the Reynolds averaged equation and 𝐷 is replaced by the 

effective turbulent diffusivity 𝐷𝑒, provided that the time scale of turbulence is much 

smaller than the scale of mean residence time. If that criterion is met, the remaining 

derivation steps for laminar flow systems may be altered for turbulent flow systems by 

replacing 𝐷 with 𝐷𝑒. Multiplication of Equation (2.17) by 𝑡 and integration gives: 

 ∫ 𝑡 𝜕𝐶
𝜕𝑡 𝑑𝑡 + ∫ ∇ ⋅ (𝑡𝑣⃗𝐶)𝑑𝑡 = ∫ ∇ ⋅ (𝐷∇(𝑡𝐶))𝑑𝑡∞

0
∞

0
∞

0  (2.18) 

Here, 𝑡 is independent of position and has been brought inside the spatial derivatives. The 

first term on the left-hand side of Equation (2.18) may be integrated by parts to give: 

 ∫ 𝑡 𝜕𝐶
𝜕𝑡 𝑑𝑡∞

0 = 𝑡𝐶|0
∞ − ∫ 𝐶𝑑𝑡∞

0  (2.19) 

The first term on the right-hand side of Equation (2.19) will be zero if 𝑡𝐶 is zero in the 

limit 𝑡 → ∞. That is, 𝐶 must approach zero faster than 𝑡 approaches infinity, indicating 

that the mean age 𝑎 can exist only if 𝑡𝐶 → 0 as 𝑡 → ∞. As such, the first term on the 

right-hand side of Equation (2.19) must equal zero so that: 

 ∫ 𝑡 𝜕𝐶
𝜕𝑡 𝑑𝑡∞

0 = − ∫ 𝐶𝑑𝑡∞
0  (2.20) 

Substitution of Equation (2.20) into Equation (2.18) and division by ∫ 𝐶𝑑𝑡∞
0  gives: 

 −1 + ∇ ⋅ {𝑣⃗ [∫ 𝑡𝐶𝑑𝑡∞
0
∫ 𝐶𝑑𝑡∞

0
]} = ∇ ⋅ {𝐷∇ [∫ 𝑡𝐶𝑑𝑡∞

0
∫ 𝐶𝑑𝑡∞

0
]} (2.21) 
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Lastly, substituting the definition of 𝑎 (Equation (2.16)), the general conservation 

equation for mean age is: 

 ∇ ⋅ (𝑣⃗𝑎) = ∇ ⋅ (𝐷∇𝑎) + 1 (2.22) 

Equation (2.22) may be simplified for incompressible flow in single-phase systems to 

give: 

 𝑣⃗ ⋅ ∇𝑎 = ∇ ⋅ (𝐷∇𝑎) + 1 (2.23) 

Equation (2.22) mirrors the same form as the conservation equations of mass and 

momentum, enabling solution by the same CFD solver. It is noted that both definitions of 

𝐶(𝑥, 𝑡) produce the same conservation equation, so mean age theory is now presently 

extended from single-phase to multiphase systems. Liu and Tilton (2010) derive 

boundary conditions for the conservation equation for mean age and are based on tracer 

concentration. Utilizing Equation (2.16) and the normal coordinate in the flow direction 

𝑥𝑛, Liu and Tilton (2010) show that suitable boundary conditions for Equations (2.22) 

and (2.23) are: 

 𝑎 = 0, at inlet (2.24) 

 𝑛̂ ⋅ ∇𝑎 = 𝜕𝑎
𝜕𝑥𝑛

= 0, on solid walls (2.25) 

 𝑛̂ ⋅ ∇𝑎 = 𝜕𝑎
𝜕𝑥𝑛

= 0, at outlet (2.26) 

Russ and Berson (2016) show that multiphase mean age theory is well validated 

by comparing experimental RTDs obtained from spatial mean age distributions to ones 

found computationally at two locations in the same water-oil flow system. Mean RTD 
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values and variances from multiphase mean age theory were within 1–3% and 3–11%, 

respectively, of experimental values. With this, mean RTD values and variances derived 

from multiphase mean age theory neared experimental values more closely than 

respective values derived from conventional transient solutions, indicating the innate 

steady-state solution associated with the theory increased the accuracy (Russ and Berson, 

2016). Multiphase mean age theory is applicable to systems of any phase type, and since 

steady-state solutions are utilized, the theory is valuable for systems with lengthy 

residence times or ages. 
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III. EXPERIMENTAL METHODS 

A. Preliminaries 

1. Purpose 

The purpose of this investigation was to utilize CFD and multiphase mean age 

theory as a way to compare a novel mean age metric determined from two-dimensional 

arterial slices with those that are used to detect and assess a stenotic artery determined 

from corresponding three-dimensional arterial renderings. Using supercomputing, 

calculations can approach a total duration on the order of days to simulate multiphase 

flow in a typical three-dimensional segment of an artery. Comparatively, simulating flow 

in a two-dimensional slice of the same segment takes on the order of about 60 minutes. If 

two-dimensional slicing can produce a similar mean age metric to its three-dimensional 

source, the more easily-processed, two-dimensional slices may be preferentially chosen 

to aid in long-term three-dimensional correlative approaches to 𝐹𝐹𝑅. 

2. Plan 

Two-dimensional arterial slices were generated from the three-dimensional source 

arteries using the computer-aided design software packages of ANSYS SpaceClaim and 

Dassault Systèmes SolidWorks. To better capture a wider range of the three-dimensional 

geometries, two orthogonal slices were created within each artery, giving two sets of ten 

(or 20 slices in total) to process. SpaceClaim was used to create two separate STEP files 

representing the three-dimensional arterial outlines, while SolidWorks was used to 

convert the outlines to two-dimensional surface entities via filling, flattening, and 

aligning. ANSYS Meshing was then used to create a discretized domain of a geometric 

mesh of at least 20,000 elements on the slices. Following this, ANSYS Fluent was used 
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to simulate pulsing blood flow and to calculate the mean ages of the plasma and red 

blood cell phases using user-defined scalars. From this, the mean ages of the two-

dimensional slices were compared to nominal mean residence times to characterize the 

age impact of an occurring stenosis. Finally, the mean ages of the two-dimensional slices 

were then compared to respective three-dimensional mean age values of the source 

renderings for final assessment. 

B. Materials 

A Lenovo ThinkPad with an Intel Core i5-3320M CPU @ 2.60 GHz was used to 

run the ANSYS 17.1 software packages of Workbench, SpaceClaim, Meshing, and 

Fluent on Windows 7. With this, a MacBook Pro with an Intel Core i5-6267U CPU @ 

2.90 GHz was used in conjunction with Parallels Desktop for Mac to run Dassault 

Systèmes SolidWorks on Windows 10. 

DICOM-derived, three-dimensional STL files of arteries rendered by coronary 

angiograms were provided for slicing treatment. User-defined function (UDF) files were 

used to generate pulsing at the boundaries. Each UDF differs by multiplicative constants 

on the piecewise functions of Equations 3.1 and 3.2: 

 𝑣𝑖𝑛𝑙𝑒𝑡 = {0.1,
0.26 sin(1.58𝜋(𝑡 + 0.92)),                          

0 < 𝑡 ≤ 0.42
0.42 < 𝑡 ≤ 0.9 (3.1) 

 𝑝𝑜𝑢𝑡𝑙𝑒𝑡 = {18665.13 sin(1.4𝜋(0.8𝑡 + 0.1305)) ,
−13400𝑡 + 22700,     0 < 𝑡 ≤ 0.42

0.42 < 𝑡 ≤ 0.9 (3.2) 

Sample source code for a UDF file may be seen in APPENDIX I. 
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C. Procedures for Processing Two Orthogonal Arterial Slices 

1. Geometry Generation 

Arterial slice geometry was generated using ANSYS Workbench and the two 

computer-aided design software packages of ANSYS SpaceClaim and Dassault Systèmes 

SolidWorks. The following steps describe how to create arterial slices from three-

dimensional arteries: 

a. SpaceClaim.  SpaceClaim was used to create two separate STEP files 

representing the three-dimensional arterial outlines. 

i. New Geometry Module and SpaceClaim File.  Open Workbench and 

drag a new Geometry module from the Toolbox pane to the Project 

Schematic pane. Right-click the Geometry module and click “New 

SpaceClaim Geometry...” to open SpaceClaim. 

ii. Opening the STL File.  Click File → Open and navigate to the three-

dimensional STL file. Before opening the file, click “Options...” in the 

Open window and ensure the settings highlighted in FIGURE 3.1 are 

followed: 
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FIGURE 3.1 - STL File Opening Settings in SpaceClaim 

Click “OK” in the SpaceClaim Options window and click “Open” in the 

Open window to import the three-dimensional geometry. Importantly, 

the geometry will have boundaries of a single face nearly circular in 

shape, while the wall will be composed of hundreds of faces of various 

shape. 

iii. Line Creation.  Orthogonal markers are needed on both boundary faces 

to guide slice creation. To create orthogonal markers, choose Line from 

the ribbon. Under the Options - Sketch pane on the left, ensure the 

options highlighted in FIGURE 3.2 are followed:  
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FIGURE 3.2 - Line Options in SpaceClaim 

With Line selected from the ribbon, a grid will display on the drawing 

space. Move the cursor to a boundary face so that the grid displays 

major axes on it. FIGURE 3.3 displays this: 

 

FIGURE 3.3 - Major Axes Displayed on a Boundary Face in 

SpaceClaim 

Zooming in, draw two orthogonal lines on a boundary face that extend 

beyond the length of the face. The grid should be used to snap the lines 

and ensure orthogonality. FIGURE 3.4 displays this: 
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FIGURE 3.4 - Two Orthogonal Lines Extending Beyond a Boundary 

Face in SpaceClaim 

With the two lines now extending beyond a boundary face, the lines 

must be reduced to the constraints of the face itself. Click Select from 

the ribbon and choose one of the four line endpoints. Using a 

combination of zooming and panning, hold the Shift key and drag the 

endpoint to the extent of the associated boundary face. Repeat this 

process for the remaining three endpoints so that the lines match that of 

FIGURE 3.5: 

 

FIGURE 3.5 - Two Orthogonal Lines Reduced to the Extent of a 

Boundary Face in SpaceClaim 
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Rotating the object so that the other boundary face is visible, repeat this 

process of line creation on it. It is noted that the major axes used for the 

first face will be presented by default on the second face, and this 

ensures respective “horizontal” and “vertical” lines are kept similar. In 

total, four lines should be created. Alike lines from both faces serve as 

the boundary lines for the arterial slices. For organizational purposes, 

right-click the lines in the Structure pane and rename alike lines as 

Line1_1 and Line1_2 for Slice 1 and as Line2_1 and Line2_2 for Slice 

2. The distribution of names is shown in FIGURE 3.6, where the three-

dimensional object has been suppressed from visibility to make line 

discernment easier: 

 

FIGURE 3.6 - Line Name Distribution in SpaceClaim 

It is also noted here that the lines ending in “_1” denote what will 

eventually become inlet boundaries. The designation of inlet and outlet 

boundaries stems from choosing the face with the larger surface area to 

be the inlet. 

iv. Spline Creation.  Splines are needed on the wall of the artery to create an 

outline for both slices. To create splines, choose Spline from the ribbon. 
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SpaceClaim defaults to two-dimensional creation, so type the D key to 

activate three-dimensional space control. Begin a spline creation by 

clicking the intersection point between a line created in iii and the 

perimeter of a boundary face. Using a combination of rotating, zooming, 

and panning, click points along the length of the wall of the artery until a 

connection is made to the alike line/boundary intersection. The initial 

creation of a spline is shown in FIGURE 3.7: 

 

FIGURE 3.7 - Initial Spline Creation in SpaceClaim 

The completed spline extending the length of the artery is shown in red 

in FIGURE 3.8: 

 

FIGURE 3.8 - Completed Spline (in Red) in SpaceClaim 
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Again, connection must be made to the respective line on the other end 

of the artery. Viewing FIGURE 3.7, it is clear that the arterial wall is 

composed of numerous faces. Splines snapping to the edges of these 

faces provides a difficulty in creating connections that stay consistent 

with the curvature of the geometry. Special care in guaranteeing 

acceptable spacing between clicked points must be taken to ensure an 

adequate connection between boundary lines is made. Rotating the 

object so that the other line/boundary intersections are visible, repeat this 

process of spline creation. In total, four splines should be created that are 

nearly equally spaced and form a frame of the artery. Alike splines from 

the same axis serve as the wall for the arterial slices. For organizational 

purposes, right-click the splines in the Structure pane and rename alike 

splines as Spline1_1 and Spline1_2 for Slice 1 and as Spline2_1 and 

Spline2_2 for Slice 2. Using red and green, the distribution of names is 

shown in FIGURE 3.9, where the three-dimensional object has been 

suppressed from visibility to make spline discernment easier: 

 

FIGURE 3.9 - Spline Name Distribution in SpaceClaim 
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It is noted that the outlines for each slice are now created. It is 

recommended to click File → Save As and save as a SpaceClaim file to 

create a file checkpoint to start from should downstream issues arise. 

v. Saving As a STEP File.  The outlines of the two slices must be saved 

individually for proper analysis hereafter. To begin the process of saving 

the first slice outline, delete all geometry in the Structure pane aside 

from the two lines and two splines outlining a slice. For example, to 

isolate the outline of Slice 1, right-click and delete the arterial body 

denoted as Solid, Line2_1, Line2_2, Spline2_1, and Spline2_2 in the 

Structure pane. In doing so, the outline for Slice 1 should be solely 

present. FIGURE 3.10 displays the Structure pane (a) before and (b) 

after deletion of Slice 2 components: 

 

FIGURE 3.10 - Structure Pane (a) Before and (b) After Deletion of Slice 

2 Components in SpaceClaim 

(a) (b) 



 

38 
 

 In performing the above deletions, the only remaining components of 

geometry are those which outline Slice 1, and this is shown in FIGURE 

3.11: 

 

FIGURE 3.11 - Components of Geometry Outlining Slice 1 After 

Deletion of Slice 2 Components in SpaceClaim 

With only the outline of Slice 1 present, click File → Save As. In the 

Save As window, ensure the options highlighted in FIGURE 3.12 are 

followed: 

 

FIGURE 3.12 - Save As Window and Options for STEP File Creation in 

SpaceClaim 



 

39 
 

Click “Save” in the Save As window to create a three-dimensional STEP 

file for Slice 1. Finally, the saving process must be repeated for Slice 2. 

With SpaceClaim still open, undo the previous deletion of Slice 2 

geometry (returning to file checkpoint) and invert the components to be 

deleted and delete them. Accordingly, to isolate the outline of Slice 2, 

right-click and delete the arterial body denoted as Solid, Line1_1, 

Line1_2, Spline1_1, and Spline1_2 in the Structure pane. In doing so, 

the outline for Slice 2 should be solely present. Repeat the Save As steps 

represented by FIGURE 3.12 to create a STEP file for Slice 2. Two 

separate STEP files representing the three-dimensional arterial outlines 

have been created and are in position for SolidWorks treatment. 

b. SolidWorks.  SolidWorks was used to convert the three-dimensional arterial 

outlines to two-dimensional surface entities via filling, flattening, and aligning. 

i. New SolidWorks File.  Open SolidWorks. Click File → Open and 

navigate to one of the three-dimensional arterial outline STEP files 

created in SpaceClaim. Click “Open” in the Open window to import the 

three-dimensional geometry. Importantly, the geometry is a three-

dimensional outline in position for two-dimensional surface conversion 

via filling, flattening, and aligning. 

ii. Filling the Outline.  Choose Filled Surface from the ribbon. With the 

blue Patch Boundary box highlighted in blue, select the geometric 

outline. The three-dimensional outline will fill to create a surface, which 

is shown in process in FIGURE 3.13: 
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FIGURE 3.13 - Fill Surface Pane Magnified and the Three-Dimensional 

Outline Being Filled in SolidWorks 

Click the green checkmark under the Fill Surface pane on the left to 

confirm the filling. 

iii. Flattening the Three-Dimensional Surface.  Choose Surface Flatten from 

the ribbon. With the blue Face/Surface to Flatten box highlighted blue, 

select the surface. With the pink Vertex or Point on Edge to Flatten 

From box highlighted blue, select one of two boundary lines. Finally, 

click and drag the Accuracy handle to High. The three-dimensional 

surface will flatten to create a two-dimensional surface, which is shown 

in process in FIGURE 3.14: 
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FIGURE 3.14 - Flatten Pane Magnified and the Three-Dimensional 

Surface Being Flattened in SolidWorks 

Click the green checkmark under the Flatten pane on the left to confirm 

the flattening. 

iv. Aligning the Surface.  Click Insert → Surface → Move/Copy... to 

initiate the aligning process. With the Bodies to Move box highlighted in 

blue, select the flattened surface. With Mate Settings box highlighted 

blue, select the flattened surface and the default Front Plane. Ensure 

Coincident is chosen below the Mate Settings box. The flattened surface 

will align to the XY-plane, which is shown in process in FIGURE 3.15: 
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FIGURE 3.15 - Move/Copy Body Pane Magnified and the Two-

Dimensional Surface Being Aligned in SolidWorks 

Click the green checkmark under the Move/Copy Body pane on the left 

to confirm the aligning. 

v. Deleting the Three-Dimensional Surface.  Two objects are visible at this 

point, but the remaining three-dimensional surface must be deleted. 

Opening the Surface Bodies folder in the hierarchy pane, right-click the 

filled surface and click Delete/Keep Body... to open the Delete/Keep 

Body... pane. Ensure the Delete/Keep Body... pane shows Delete Bodies 

under Type and the Bodies to delete box highlighted in blue shows the 

filled surface. This process is shown in FIGURE 3.16: 
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FIGURE 3.16 - Delete/Keep Body... Pane Magnified and the Three-

Dimensional Surface Being Deleted in SolidWorks 

Click the green checkmark under the Delete/Keep Body... pane on the 

left to confirm the deletion. Only a two-dimensional slice oriented on the 

XY-plane remains. 

vi. Saving As a STEP File.  The two-dimensional slice must be saved as a 

STEP file for proper analysis hereafter. Click File → Save As. In the 

Save As window, ensure the STEP AP203 file format is chosen. Click 

“Save” in the Save As window to create a two-dimensional STEP file 

for Slice 1.  

vii. Repeat for Slice 2.  Repeat the above steps in the SolidWorks subsection 

for the three-dimensional Slice 2 STEP file generated from SpaceClaim. 

As a result, two separate STEP files representing the filled, flattened, 

and aligned two-dimensional arterial slices have been created and are in 

position for Meshing treatment. 
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2. Mesh Generation 

The two generated arterial slices were meshed using the software of ANSYS 

Meshing. The following steps describe how to create a suitable mesh: 

a. Preliminary Setup.  Workbench and Meshing are used to structure the 

introductory arrangement of mesh generation. 

i. New Fluid Flow (Fluent) Module and Importing the Geometry File.  In 

Workbench, drag a new Fluid Flow (Fluent) module from the Toolbox 

pane to the Project Schematic pane. This module is added next to the 

previously inserted Geometry module. FIGURE 3.17 displays the 

Project Schematic setup: 

 

FIGURE 3.17 - Project Schematic Pane with Geometry and Fluid Flow 

(Fluent) Modules in Workbench 

To import the proper geometry, right-click the Geometry cell in the 

Fluid Flow (Fluent) module and click Import Geometry → Browse... and 

browse to one of the two-dimensional arterial slice STEP files created in 

SolidWorks. Click “Open” in the Open window. A green checkmark 

will display in the Geometry cell to confirm the importing. 
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ii. Initial Meshing Preferences.  Open Meshing by double-clicking the 

Mesh cell in the Fluid Flow (Fluent) Module. In Meshing, click Mesh 

from the Outline pane on the left. The Details of “Mesh” pane will 

display under the Outline pane. In the Details of “Mesh” pane, ensure 

Fluent is chosen as the Solver Preference under the Defaults group. In 

the same pane, choose “Proximity and Curvature” for Size Function and 

“Fine” for Relevance Center under the Sizing group. These preferences 

are highlighted in FIGURE 3.18: 

 

FIGURE 3.18 - Details of “Mesh” Pane Preferences in Meshing 

b. Meshing Controls.  Controls must be applied to construct a working mesh. 

i. Body Sizing.  Right-click Mesh from the Outline pane and click Insert. 

FIGURE 3.19 displays the Insert controls:  
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FIGURE 3.19 - Insert Controls in Meshing 

Click Sizing. The Details of “Mesh” pane will convert to the Details of 

“Sizing” - Sizing pane. Geometry under the Scope group will display No 

Selection. To select the proper geometry, click the green Body tool from 

the ribbon and select the slice in the Geometry space. The slice will turn 

green. In the Details of “Sizing” - Sizing pane, click Apply for 

Geometry under the Scope group. FIGURE 3.20 displays the resulting 

pane, which converts to “Body Sizing” after clicking Apply: 

 

FIGURE 3.20 - Details of “Body Sizing” - Sizing Pane in Meshing 
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Importantly, Geometry under the Scope group displays “1 Body,” 

confirming proper selection has been made. 

ii. Inflation.  Right-click Mesh from the Outline pane again and click 

Insert. As seen in FIGURE 3.19, click Inflation. Geometry under the 

Scope group and Boundary under the Definition group will display No 

Selection. To select the proper geometry, click the green Face tool from 

the ribbon and select the slice face in the Geometry space. The slice face 

will turn green. In the Details of “Inflation” - Inflation pane, click Apply 

for Geometry under the Scope group. In a similar manner, click the 

green Edge tool from the ribbon and select the two wall edges of the 

slice in the Geometry space. The two wall edges of the slice will turn 

green. In the Details of “Inflation” - Inflation pane, click Apply for 

Boundary under the Definition group. With this, change the number of 

inflation layers to “10” by toggling to the number for Maximum Layers 

under the Definition group. FIGURE 3.21 displays the resulting pane: 

 

FIGURE 3.21 - Details of “Inflation” - Inflation Pane in Meshing 
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Importantly, Geometry under the Scope group displays “1 Face,” 

Boundary under the Definition group displays “2 Edges,” and the 

Maximum Layers under the Definition group displays 10, confirming 

proper selections and settings have been made.  

iii. Named Selections.  For downstream Fluent processing, Named 

Selections must be applied to the inlet, outlet, wall, and interior of the 

slice. To define the inlet, begin by clicking the green Edge tool from the 

ribbon and selecting the larger of the two boundary edges. Right-click 

and choose Create Named Selection. Name the selection as inlet in the 

Selection Name window, ensure Apply selected geometry is ticked, and 

click “OK.” FIGURE 3.22 displays the process of creating a Named 

Selection for the inlet: 

 

FIGURE 3.22 - Creating a Named Selection for the Inlet in Meshing 

Repeat the process for the outlet, wall, and interior. The outlet is the 

other boundary edge, while the wall is defined by the same wall edges as 

in the Inflation steps. The interior is the face of the slice, and it is named 

“artery” for clarity. This, and the remaining distribution of color-coded 

Named Selections, is shown in FIGURE 3.23: 
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FIGURE 3.23 - Named Selection Distribution in Meshing 

c. Processing and Requirements.  Proper processing to achieve set mesh 

requirements must occur to create a final mesh suitable for downstream use. 

i. Mesh Construction and Mesh Count.  Begin the meshing process by 

clicking Generate Mesh at the top of the ribbon. After processing, click 

Show Mesh at the top of the ribbon to display the mesh. Upon 

inspection, inflation layers line the wall and a mesh has been created, but 

the mesh count must be checked for acceptable resolution. To begin the 

check, click Mesh from the Outline pane on the left. The Details of 

“Mesh” pane will display under the Outline pane. In the Details of 

“Mesh” pane, review Elements under the Statistics group. This is 

highlighted in FIGURE 3.24: 
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FIGURE 3.24 - Checking Mesh Count in the Details of “Mesh” Pane in 

Meshing 

The number associated with Elements represents the mesh count. This 

value should be no less than 20,000. The mesh count is increased by 

decreasing the Element Size under the Definition section in the Details 

of “Body Sizing” - Sizing pane, which is seen in FIGURE 3.20. 

Typically, an Element Size of 0.10 mm will produce a mesh count near 

20,000. After changing the Element Size value in FIGURE 3.20, click 

Generate Mesh again, inspect the mesh using Show Mesh, and check the 

mesh count in the Details of “Mesh” Pane for a value of at least 20,000. 

ii. Repeat for Slice 2.  Repeat the above steps in the Mesh Generation 

subsection for the other two-dimensional arterial slice STEP file created 

in SolidWorks. As a result, two separate modules containing the meshed 

slices have been created and are in position for Fluent treatment. 
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3. Fluent Case Processing 

Blood flow through the two meshed arterial slices was simulated using the 

software of ANSYS Fluent. The following steps describe how to run a suitable case: 

a. Preliminary Setup.  Workbench is used to structure the introductory 

arrangement of Fluent cases. 

i. Opening Fluent Launcher and Fluent.  In Workbench, double-click the 

Setup cell in the previously inserted Fluid Flow (Fluent) Module. Fluent 

Launcher will open. Verify that the default settings restrict 2D for 

Dimension, and ensure the setting highlighted in FIGURE 3.25 is 

followed: 

 

FIGURE 3.25 - Fluent Launcher Window in Workbench 

Click “OK” to open Fluent. 

b. Setup.  The Setup group in the Tree hierarchy arranges the most common 

system setup tasks. 

i. General.  Click General in the Tree hierarchy to display the General 

pane, and ensure the settings highlighted in FIGURE 3.26 are followed: 
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FIGURE 3.26 - General Pane in Fluent 

ii. Models.  Click Models in the Tree hierarchy to display the Models pane, 

and select Multiphase - Off. To activate this model, click “Edit...” at the 

bottom of the Models pane. The Multiphase Model window will open, 

where the settings highlighted in FIGURE 3.27 should be applied: 

 

FIGURE 3.27 - Multiphase Model Window in Fluent 
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Click “OK” to activate the model. In the Models pane, activation is 

complete if the model displays “Multiphase - Eulerian.” With this, 

ensure that the Viscous model displays the default “Viscous - Laminar.”  

iii. Materials.  Click Materials in the Tree hierarchy to display the Materials 

pane. Default fluid and solid materials of air and aluminum, 

respectively, will be present. Air will be replaced with the two phases of 

plasma and red blood cells, while aluminum will be kept unchanged. 

With Fluid highlighted, click “Create/Edit...” at the bottom of the 

Materials pane. The Create/Edit Materials window will open, where the 

settings highlighted in FIGURE 3.28 for plasma should be applied: 

  

FIGURE 3.28 - Create/Edit Materials Window for Plasma in Fluent 

In FIGURE 3.28, a density of 1,003 kg m-3 is used, and a viscosity of 

0.001 kg m-1 s-1 is used. Similar steps may be taken to define red blood 

cells as a material. For red blood cells, however, a density of 1,096 kg 

m-3 is used, and viscosity is inserted by changing its drop-down to “user-

defined” and clicking “Edit...” to the right of it. The car_yas_visc option 
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is chosen as the viscosity in the User-Defined Functions window, as 

shown in FIGURE 3.29: 

  

FIGURE 3.29 - User-Defined Functions Window with car_yas_visc 

Viscosity Selection for Red Blood Cells in Fluent 

Click “OK” to activate the model, and click “Close” in the Create/Edit 

Materials window. It is noted that the car_yas_visc option will only be 

available after a user-defined function is interpreted, as in FIGURE 3.33. 

iv. Defining Phases.  Phases are defined by clicking List/Show All... above 

Phases under the Setting Up Physics tab in the ribbon. The Phases 

window will open, as shown in FIGURE 3.30: 

 

FIGURE 3.30 - Phases Window in Fluent 
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Ensure the primary (phase-1) and secondary (phase-2) phases are plasma 

and red blood cells, respectively, by clicking “Edit...” and choosing the 

proper material from the Phase Material drop-down. Red blood cells 

require additional settings for phasic definition. As such, enable 

Granular in the Secondary Phase window to reveal property input. This 

is shown in FIGURE 3.31, where the highlighted settings should be 

applied: 

 

FIGURE 3.31 - Secondary Phase Window in (a) General and with the 

(b) Granular Properties Magnified in Fluent 

Phasic interaction settings are changed by clicking “Interaction...” at the 

bottom of the Phases window seen in FIGURE 3.30. Interaction changes 

for virtual mass, lift, collisions, mass, surface tension, and interfacial 

area are available, but the drag coefficient is the only item in need of 

modification. Keeping all other interactions default, FIGURE 3.32 

displays the highlighted setting to be changed for the drag coefficient: 

(a) (b) 
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FIGURE 3.32 - Phase Interaction Window in (a) General and with the 

(b) Drag Coefficient Settings Magnified in Fluent 

v. Interpreting a User-Defined Function and Setting User-Defined Scalars.  

To permit use of scalars, a user-defined function must first be read by 

Fluent. Click Functions → Interpreted... above User-Defined under the 

User-Defined tab in the ribbon. The Interpreted UDFs window will 

open. Click Browse... and locate the proper source code file. The 

resulting window is shown in FIGURE 3.33: 

 

FIGURE 3.33 - Interpreted UDFs Window in Fluent 

Click “Interpret” in the Interpreted UDFs window and then click 

“Close.” With this, scalar definition begins by clicking Scalars... above 

User-Defined under the User-Defined tab in the ribbon. The User-

(a) 

(b) 
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Defined Scalars window will open, where the settings highlighted in 

FIGURE 3.34 should be applied: 

 

FIGURE 3.34 - User-Defined Scalars Window for (a) Red Blood Cells 

and (b) Plasma in Fluent 

Click “OK” to confirm the addition of the two scalars. Viewing 

FIGURE 3.34, it is stated that phase-2 now represents red blood cells 

and Scalar0, while phase-1 now represents plasma and Scalar1. 

vi. Mean Ages of the Phases Using User-Defined Scalars - Scalar0.  It is 

initially noted that this subsection demonstrates the steps necessary for 

mean age calculation setup with respect to Scalar0, with analogous 

images of Scalar1 setup displayed in the succeeding subsection. 

Recognizing this, the material properties of red blood cells must be 

updated to reflect scalar impact. Reopen the Create/Edit Materials 

window for red blood cells, which will now include the UDS Diffusivity 

option highlighted in FIGURE 3.35: 

(a) (b) 
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FIGURE 3.35 - Updated Create/Edit Materials Window for Scalar0 in 

Fluent 

UDS diffusivity is inserted by changing its drop-down to “defined-per-

uds” and clicking “Edit...” to the right of it. A coefficient is entered in 

the UDS Diffusion Coefficients window, as shown highlighted in 

FIGURE 3.36:  

 

FIGURE 3.36 - UDS Diffusion Coefficients Window for Scalar0 in 

Fluent 

Click “OK” to confirm the coefficient, and click “Change/Create” and 

then “Close” in the Create/Edit Materials window. With this, to apply 

the scalar to the proper zone of geometry, click Cell Zone Conditions in 
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the Tree hierarchy to display the Cell Zone Conditions pane. With the 

phase of red blood cells (phase-2) chosen in the Phase drop-down in the 

pane, click “Edit...” to open the Fluid window. Enable Source Terms and 

click “Edit...” to the right of User Scalar 0 under the Source Terms tab. 

This will open the User Scalar 0 sources window. The same magnitude 

of density for red blood cells used previously (1,096) should be entered 

as the constant value. This process, with proper settings highlighted, is 

shown in FIGURE 3.37: 

  

FIGURE 3.37 - Fluid and User Scalar 0 Sources Windows for Scalar0 in 

Fluent 

Click “OK” in both windows to confirm scalar zone application. Finally, 

to apply the scalar in the boundary conditions, click Boundary 

Conditions in the Tree hierarchy to display the Boundary Conditions 

pane. With phase-2 still chosen in the Phase drop-down in the pane, 

select the inlet boundary and click “Edit...” to open the Velocity Inlet 

window. Three tabs of options are available, and the settings to be 

changed are shown highlighted in FIGURE 3.38: 
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FIGURE 3.38 - Velocity Inlet Window for Scalar0 Displaying (a) 

Momentum, (b) Multiphase, and (c) UDS Settings in Fluent 

Click “OK” to confirm the inlet boundary condition. With phase-2 still 

chosen in the Phase drop-down in the Boundary Conditions pane, select 

(a) 

(c) 

(b) 
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the outlet boundary and click “Edit...” to open the Pressure Outlet 

window. Two tabs of options are available, and the default settings to 

ensure are shown in FIGURE 3.39: 

 

FIGURE 3.39 - Pressure Outlet Window for Scalar0 Displaying (a) 

Multiphase and (b) UDS Settings in Fluent 

Click “OK” to confirm the outlet boundary condition. 

vii. Mean Ages of the Phases Using User-Defined Scalars - Scalar1.  While 

previous steps have defined the scalar for red blood cells, similar steps 

may be taken for scalar definition of plasma. FIGURES 3.40–44 display 

Scalar1 analogs of the preceding steps of Scalar0 definition: 

(a) 

(b) 
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FIGURE 3.40 - Updated Create/Edit Materials Window for Scalar1 in 

Fluent 

  

FIGURE 3.41 - UDS Diffusion Coefficients Window for Scalar1 in 

Fluent 

 

FIGURE 3.42 - Fluid and User Scalar 1 Sources Windows for Scalar1 in 

Fluent 
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FIGURE 3.43 - Velocity Inlet Window for Scalar1 Displaying (a) 

Momentum and (b) UDS Settings in Fluent 

 

FIGURE 3.44 - Pressure Outlet Window for Scalar1 Displaying UDS 

Settings in Fluent 

(a) 

(b) 
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c. Solution.  The Solution group in the Tree hierarchy arranges solution setup and 

calculation task direction. 

i. Solution Methods.  Click Solution Methods in the Tree hierarchy to 

display the Solution Methods pane, and ensure the settings highlighted 

in FIGURE 3.45 are followed: 

 

FIGURE 3.45 - Solution Methods Pane in Fluent 

ii. Solution Controls.  Click Solution Controls in the Tree hierarchy to 

display the Solution Controls pane, and ensure the settings highlighted in 

FIGURE 3.46 are followed: 
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 FIGURE 3.46 - Solution Controls Pane in (a) General and with the (b) 

Under-Relaxation Factors Magnified in Fluent 

It is noted that the value of User Scalar 0 shown in FIGURE 3.46(b) may 

need infrequent reduction if divergence errors emerge. As such, this 

value may be halved until divergence is mitigated and a solution is 

calculated. 

iii. Monitors.  Click Monitors in the Tree hierarchy to display the Monitors 

pane. Select Residuals - Print, Plot under Residuals, Statistic and Force 

Monitors in the pane, and click “Edit...” below it. The Residual Monitors 

window will open, where the settings highlighted in FIGURE 3.47 

should be applied: 

(a) (b) 
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FIGURE 3.47 - Residual Monitors Window in (a) General and with the 

(b) Equations Magnified in Fluent 

Click “OK” to confirm the residual monitor settings. 

iv. Solution Initialization.  Click Solution Initialization in the Tree 

hierarchy to display the Solution Initialization pane. With Hybrid 

Initialization chosen from the Initialization Methods options, click 

“Initialize.” Appropriate starting values are generated for necessary 

system components, but the initial zero values of the scalars must be 

changed manually to further assist in solution convergence. As such, 

select Standard Initialization from the Initialization Methods options, 

(a) 

(b) 
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and apply the nonzero values highlighted in FIGURE 3.48 for the 

scalars: 

 

FIGURE 3.48 - Solution Initialization Pane in (a) General and with the 

(b) Initial Values Magnified in Fluent 

Click “Initialize” again to prime the system for solution calculation. 

v. Run Calculation.  Click Run Calculation in the Tree hierarchy to display 

the Run Calculation pane, where the settings highlighted in FIGURE 

3.49 should be applied: 

(a) (b) 
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FIGURE 3.49 - Run Calculation Pane in Fluent 

Click “Calculate” to begin solution calculation. 
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IV. RESULTS AND DISCUSSION 

A. Scope of Investigated Patient Numbers, Source Renderings, and Created Slices 

Results are presented for 10 patient cases, five below and five above the 𝐹𝐹𝑅 

threshold of 0.80 reported by Min et al. (2015) as the value below which a cardiologist 

intervenes with stent placement to prevent ischemia. The 10 patient cases are listed in 

TABLE 4.1: 

TABLE 4.1 

VALUES OF 𝐹𝐹𝑅 AND COMPONENTS OF THE ARTERIAL TREE 

REPRESENTING THE PATIENT NUMBERS USED IN THIS INVESTIGATION 

The three-dimensional source renderings of low and high 𝐹𝐹𝑅 used for two-dimensional 

slicing are shown, respectively, in FIGURES 4.1–5 and FIGURES 4.6–10: 

 

 

 

 

 

Patient 
Number 𝑭𝑭𝑹 Arterial Tree Component 

004 0.76 

“low” 

mid left anterior descending 
005 0.75 mid right coronary 
017 0.72 left anterior descending 
019 0.76 posterior descending 
041 0.70 proximal left anterior descending 
045 0.83 

“high” 

mid left anterior descending 
046 0.98 distal right coronary 
058 0.98 proximal left circumflex 
061 0.97 mid right coronary 
075 0.81 mid left anterior descending 
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FIGURE 4.1 - Depictions of the (a) Three-Dimensional Source Rendering and Two-

Dimensional (b) Slice 1 and (c) Slice 2 for the Artery of Patient 004 

(a) 

𝐹𝐹𝑅: 0.76 

(b) 

(c) 
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FIGURE 4.2 - Depictions of the (a) Three-Dimensional Source Rendering and Two-

Dimensional (b) Slice 1 and (c) Slice 2 for the Artery of Patient 005 

(a) 

𝐹𝐹𝑅: 0.75 

(b) 

(c) 
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FIGURE 4.3 - Depictions of the (a) Three-Dimensional Source Rendering and Two-

Dimensional (b) Slice 1 and (c) Slice 2 for the Artery of Patient 017 

(a) 

𝐹𝐹𝑅: 0.72 

(b) 

(c) 
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FIGURE 4.4 - Depictions of the (a) Three-Dimensional Source Rendering and Two-

Dimensional (b) Slice 1 and (c) Slice 2 for the Artery of Patient 019 

 

 

 

(a) 

𝐹𝐹𝑅: 0.76 

(b) 

(c) 
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FIGURE 4.5 - Depictions of the (a) Three-Dimensional Source Rendering and Two-

Dimensional (b) Slice 1 and (c) Slice 2 for the Artery of Patient 041 

(a) 

𝐹𝐹𝑅: 0.70 

(b) 

(c) 
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FIGURE 4.6 - Depictions of the (a) Three-Dimensional Source Rendering and Two-

Dimensional (b) Slice 1 and (c) Slice 2 for the Artery of Patient 045 

(a) 

𝐹𝐹𝑅: 0.83 

(b) 

(c) 
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FIGURE 4.7 - Depictions of the (a) Three-Dimensional Source Rendering and Two-

Dimensional (b) Slice 1 and (c) Slice 2 for the Artery of Patient 046 

(a) 

𝐹𝐹𝑅: 0.98 

(b) 

(c) 
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FIGURE 4.8 - Depictions of the (a) Three-Dimensional Source Rendering and Two-

Dimensional (b) Slice 1 and (c) Slice 2 for the Artery of Patient 058 

(a) 

𝐹𝐹𝑅: 0.98 

(b) 

(c) 
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FIGURE 4.9 - Depictions of the (a) Three-Dimensional Source Rendering and Two-

Dimensional (b) Slice 1 and (c) Slice 2 for the Artery of Patient 061 

(a) 

𝐹𝐹𝑅: 0.97 

(b) 

(c) 
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FIGURE 4.10 - Depictions of the (a) Three-Dimensional Source Rendering and Two-

Dimensional (b) Slice 1 and (c) Slice 2 for the Artery of Patient 075 

Fluent was used to simulate pulsing blood flow in each of the depictions shown in 

FIGURES 4.1–10 and to calculate the mean ages of the plasma and red blood cell phases 

using user-defined scalars. With Scalar1 representing plasma and Scalar0 representing 

red blood cells, it is noted that only Scalar0 results are presented in this section. Since 

(a) 

𝐹𝐹𝑅: 0.81 

(b) 

(c) 
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plasma is believed to behave more as a continuous phase within blood, its flow may be 

less impacted by a stenosis than the fluid’s red blood cells. While red blood cells are not 

strictly granular, the granular method of modeling used for red blood cells is an attempt 

to create a simplified model of collision at a constriction within an artery. In using this 

setup, the red blood cell phase provides mean age data that the continuous, unaffecting 

plasma phase simply cannot. These data are shown in subsequent plots of Scalar0 mean 

age. For completeness, however, plots of Scalar1 mean age may be seen in APPENDIX 

II. 

B. Fluent Results of the Three-Dimensional Source Renderings 

Fluent was used to simulate pulsing blood flow in the three-dimensional source 

renderings while tracking a user-defined scalar (Scalar0), representing the mean age of 

red blood cells, over the duration of flow. The plots displayed in this subsection 

subsequently represent the mean age of red blood cells as a function of elapsed flow time. 

Plots of Scalar0 mean age typically resemble periodic behavior as a result of the pulsing 

boundary conditions. Increased peaks of mean age varying from standard periodicity, 

however, are indicators of stenotic character along the flow path as blood attempts to 

transport from inlet to outlet but is impeded. In other words, an increase in mean age is 

attributed to an obstructing stenosis. With this, the plots utilize area-weighted averaging 

of the scalar value instead of mass-weighted averaging. Mean age itself is a calculation of 

the average time of all material passing through a given location rather than the average 

time of all material wherever it may be in the system. As a result, area-weighted average 

is more relevant than mass-weighted averaging for the three-dimensional source 

rendering systems. 
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The five cases of low 𝐹𝐹𝑅 are shown in FIGURES 4.11–15: 

   

  FIGURE 4.11 - Area-Weighted Average of Scalar0 for the Three-Dimensional Source 

Rendering of Patient 004 

   

FIGURE 4.12 - Area-Weighted Average of Scalar0 for the Three-Dimensional Source 

Rendering of Patient 005 

   

FIGURE 4.13 - Area-Weighted Average of Scalar0 for the Three-Dimensional Source 

Rendering of Patient 017 
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FIGURE 4.14 - Area-Weighted Average of Scalar0 for the Three-Dimensional Source 

Rendering of Patient 019 

   

FIGURE 4.15 - Area-Weighted Average of Scalar0 for the Three-Dimensional Source 

Rendering of Patient 041 

As shown, each of the five low 𝐹𝐹𝑅 source renderings exhibit an increased peak of 

significantly large magnitude. The appearance of high peaks may be attributed to stenotic 

character present within a source rendering. With this, patients of lower 𝐹𝐹𝑅 value are 

observed to provide the highest elevation in peak. This is to say that Patient 041, with its 

𝐹𝐹𝑅 value of 0.70, displays the highest peak value, while Patients 004 and 019, with 

their 𝐹𝐹𝑅 value of 0.76, exhibit the lowest increase in mean age. These results align with 

the expectations associated with an 𝐹𝐹𝑅 value below 0.80 impacting an artery. 

The five cases of high 𝐹𝐹𝑅 are shown in FIGURES 4.16–20: 
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FIGURE 4.16 - Area-Weighted Average of Scalar0 for the Three-Dimensional Source 

Rendering of Patient 045 

   

FIGURE 4.17 - Area-Weighted Average of Scalar0 for the Three-Dimensional Source 

Rendering of Patient 046 

   

FIGURE 4.18 - Area-Weighted Average of Scalar0 for the Three-Dimensional Source 

Rendering of Patient 058 
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FIGURE 4.19 - Area-Weighted Average of Scalar0 for the Three-Dimensional Source 

Rendering of Patient 061 

   

FIGURE 4.20 - Area-Weighted Average of Scalar0 for the Three-Dimensional Source 

Rendering of Patient 075 

As shown, three of the five high 𝐹𝐹𝑅 source renderings (i.e., those from Patients 045, 

046, and 058) exhibit the beginnings of periodicity and/or a slight peak of mean age 

value. As a whole, these source renderings align with the expectations governed by a high 

𝐹𝐹𝑅 value, which are expressed by their generally low mean age values. With this, 

however, there are increasingly elevated peaks present in the plots for Patients 061 and 

075. Nevertheless, these peaks do not reach the same magnitudes of elevation as shown 

in renderings of low 𝐹𝐹𝑅 value, and these increased peaks of mean age may be attributed 

to natural features of these particular arteries. 
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C. Fluent Results of the Two-Dimensional Arterial Slices 

1. Plots of Scalar0 Mean Age and Nominal Mean Residence Time Comparison 

Fluent was used to simulate pulsing blood flow in the two-dimensional arterial 

slices while tracking a user-defined scalar (Scalar0), representing the mean age of red 

blood cells, over the duration of flow. Again, it is stated that increased peaks of mean age 

varying from standard periodicity are indicators of stenotic character along the flow path 

as blood attempts to transport from inlet to outlet but is impeded. Succeeding plots with 

increased peaks of mean age are shaded gold. With this, the plots utilize area-weighted 

averaging of the scalar value instead of mass-weighted averaging for the same reason 

explained in the preceding subsection. 

The five cases of low 𝐹𝐹𝑅 are shown in FIGURES 4.21–25: 

   

   

FIGURE 4.21 - Area-Weighted Average of Scalar0 for (a) Slice 1 and (b) Slice 2 of 

Patient 004 

 

0
0.2
0.4
0.6
0.8

1

0 0.5 1 1.5 2

A
re

a-
W

ei
gh

te
d 

A
ve

ra
ge

 
of

 S
ca

la
r0

Flow Time [s]

0
0.2
0.4
0.6
0.8

1

0 0.5 1 1.5 2

A
re

a-
W

ei
gh

te
d 

A
ve

ra
ge

 
of

 S
ca

la
r0

Flow Time [s]

(a) (b) 



 

86 
 

   

   

FIGURE 4.22 - Area-Weighted Average of Scalar0 for (a) Slice 1 and (b) Slice 2 of 

Patient 005 

   

   

FIGURE 4.23 - Area-Weighted Average of Scalar0 for (a) Slice 1 and (b) Slice 2 of 

Patient 017 

   

   

FIGURE 4.24 - Area-Weighted Average of Scalar0 for (a) Slice 1 and (b) Slice 2 of 

Patient 019 
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FIGURE 4.25 - Area-Weighted Average of Scalar0 for (a) Slice 1 and (b) Slice 2 of 

Patient 041 

As shown, four out of the five low 𝐹𝐹𝑅 cases contain at least one slice (shaded in gold) 

with increased peaks of Scalar0 value. Patient 019 saw increased peaks in both arterial 

slices, while Patients 005, 017, and 041 contained increased peaks in only one of the two 

slices. The appearance (and non-appearance) of high peaks may be attributed to the 

arbitrarily chosen planes for slicing. As discussed in EXPERIMENTAL METHODS, 

splines were used to create orthogonal slices from a given three-dimensional STL file. 

Only two angles out of 360° were created, leading to the possibility of uncaptured 

stenotic character within the three-dimensional rendering. Since arteries (and renderings 

of them) are not perfectly cylindrical, the potential of observing increased peaks in plots 

of Scalar0 mean age is highly dependent on the angular direction chosen for any sliced 

plane. The limitation in capturing stenotic character is a possibility in using only two 

slices, and this idea serves to explain the unexpected slice singularities of constant peak 

value observed and left unshaded in Patients 004, 005, 017, and 041. 

The five cases of high 𝐹𝐹𝑅 are shown in FIGURES 4.26–30: 
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FIGURE 4.26 - Area-Weighted Average of Scalar0 for (a) Slice 1 and (b) Slice 2 of 

Patient 045 

   

   

FIGURE 4.27 - Area-Weighted Average of Scalar0 for (a) Slice 1 and (b) Slice 2 of 

Patient 046 

   

   

FIGURE 4.28 - Area-Weighted Average of Scalar0 for (a) Slice 1 and (b) Slice 2 of 

Patient 058 
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FIGURE 4.29 - Area-Weighted Average of Scalar0 for (a) Slice 1 and (b) Slice 2 of 

Patient 061 

   

   

FIGURE 4.30 - Area-Weighted Average of Scalar0 for (a) Slice 1 and (b) Slice 2 of 

Patient 075 

As shown, four out of the five high 𝐹𝐹𝑅 cases resemble periodic functions with a nearly 

constant peak value. In fact, aside from Slice 2 of Patient 075, all other slices across the 

five cases demonstrate expected behavior. Slice 2 of Patient 075 outlies the total data set 

and could be ascribed to natural features of the actual artery that may only be expressed 

at this one arbitrary angle. 

The peak data of the Scalar0 FIGURES may be tabulated to show the significant 

difference of mean age between low and high values of 𝐹𝐹𝑅. With this, peak data of the 

Scalar0 FIGURES may be compared to nominal values representing mean residence 
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times of blood flow if the geometry were not stenotic. The mean residence times are 

determined by dividing the volume of the three-dimensional source rendering by the 

volumetric flow rate governing the flow and dictated by the boundary conditions. The 

data containing mean age as a function of 𝐹𝐹𝑅 and its comparison to nominal mean 

residence time are shown in TABLE 4.2: 

TABLE 4.2 

A COMPARISON OF MEAN AGE VALUES BETWEEN LOW AND HIGH 𝐹𝐹𝑅 

AND TO NOMINAL MEAN RESIDENCE TIMES FOR THE TWO-DIMENSIONAL 

ARTERIAL SLICES 

Patient 
Number 𝑭𝑭𝑹 

Nominal Mean 
Residence Time 

[s] 

Peak Scalar0 (Mean Age) Percent Difference (× 10–1) 

Slice 1 Slice 2 Slice 1 Slice 2 

004 0.76 

“low” 

1.4 × 10–1 8.8 × 10–1 8.3 × 10–1 53% 50% 

005 0.75 9.1 × 10–2 1.5 × 103 5.1 × 10–1 164778% 46% 

017 0.72 2.5 × 10–1 4.0 × 100 1.5 × 100 149% 48% 

019 0.76 1.5 × 10–1 1.6 × 103 2.3 × 101 111225% 1533% 

041 0.70 4.9 × 10–2 4.8 × 104 4.7 × 10–1 9672560% 86% 

045 0.83 

“high” 

2.7 × 10–1 5.3 × 10–1 5.3 × 10–1 9% 10% 

046 0.98 3.3 × 10–1 2.1 × 100 2.1 × 100 53% 53% 

058 0.98 3.5 × 10–1 7.1 × 10–1 7.4 × 10–1 11% 11% 

061 0.97 3.0 × 10–1 1.4 × 100 1.3 × 100 37% 36% 

075 0.81 2.2 × 10–2 6.6 × 10–1 2.2 × 104 291% 9809017% 

TABLE 4.2 may be used to emphasize the difference in mean age between low and high 

𝐹𝐹𝑅. While high 𝐹𝐹𝑅 cases are observed to range in orders of magnitude from tenths to 

ones, low 𝐹𝐹𝑅 cases generally exhibit a mean age increased by no less than one order of 

magnitude. Although not always the case (as in Patients 004 and 017), this observation 

serves to support the notion of mean age increasing as 𝐹𝐹𝑅 decreases. In addition to this, 

TABLE 4.2 serves to emphasize the difference between mean ages and nominal mean 
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residence times. The values differ more greatly in cases of low 𝐹𝐹𝑅 than those for cases 

of high 𝐹𝐹𝑅, and this is enumerated in the columns of Percent Difference. With this, 

Slice 1 values for low 𝐹𝐹𝑅 cases are distinctly higher than respective ones for Slice 2, 

which is evidenced by the increased peaks shown previously in the gold-shaded plots in 

FIGURES 4.22–25. 

The directionality of a slice may have an effect in prompting increased mean age 

values, so it is noted here that Slice 1 and Slice 2 geometries were typically cut 

horizontally and vertically, respectively, to the trimetric view given by default in 

SpaceClaim. An example of this is shown in FIGURE 3.9 in EXPERIMENTAL 

METHODS. Resulting treatment in SolidWorks provided the slices shown in FIGURE 

4.6, where Slice 1 is now oriented in the XY-plane nearly vertically and Slice 2 is now 

oriented nearly horizontally. This procedure was used for all slice creation, provided that 

the curvature of the three-dimensional rendering permitted its fulfillment. As shown in 

FIGURES 4.1–10, most slices follow this orientation scheme, but there are exceptions 

(such as Patient 019 and Patient 046). In viewing these FIGURES and TABLE 4.2, 

however, the patients with increased mean age values do not appear to find a correlation 

with the orientation of the slice. Directly, while Slice 1 geometries are typically vertical 

and represent the cases where increased peaks in mean age are present, Patient 019 

displays increased mean age values while both slices are nearly horizontal. 

2. Plots of Velocity Contours 

The plots displayed in this subsection represent the computed velocity contours of 

the red blood cells phase. It is noted that velocity contours of the plasma phase are not 

shown since they are indistinguishable with the velocity contours of red blood cells. The 
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range of velocity magnitude gradates from blue to red as velocity increases, and the slice-

specific spectrum of the velocity is shown in each of the depictions. The velocity 

contours for the five cases of low and five cases of high 𝐹𝐹𝑅 are shown, respectively, in 

FIGURES 4.31–35 and FIGURES 4.36–40: 

 

FIGURE 4.31 - Velocity Contours for (a) Slice 1 and (b) Slice 2 of Patient 004 

 

FIGURE 4.32 - Velocity Contours for (a) Slice 1 and (b) Slice 2 of Patient 005 

(a) (b) 

𝐹𝐹𝑅: 0.76 

(a) (b) 

𝐹𝐹𝑅: 0.75 
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FIGURE 4.33 - Velocity Contours for (a) Slice 1 and (b) Slice 2 of Patient 017 

 

FIGURE 4.34 - Velocity Contours for (a) Slice 1 and (b) Slice 2 of Patient 019 

(a) (b) 

𝐹𝐹𝑅: 0.72 

(a) (b) 

𝐹𝐹𝑅: 0.76 



 

94 
 

 

FIGURE 4.35 - Velocity Contours for (a) Slice 1 and (b) Slice 2 of Patient 041 

 

FIGURE 4.36 - Velocity Contours for (a) Slice 1 and (b) Slice 2 of Patient 045 

(a) (b) 

𝐹𝐹𝑅: 0.70 

(a) (b) 

𝐹𝐹𝑅: 0.83 
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FIGURE 4.37 - Velocity Contours for (a) Slice 1 and (b) Slice 2 of Patient 046 

 

FIGURE 4.38 - Velocity Contours for (a) Slice 1 and (b) Slice 2 of Patient 058 

(a) (b) 

𝐹𝐹𝑅: 0.98 

(a) (b) 

𝐹𝐹𝑅: 0.98 
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FIGURE 4.39 - Velocity Contours for (a) Slice 1 and (b) Slice 2 of Patient 061 

 

FIGURE 4.40 - Velocity Contours for (a) Slice 1 and (b) Slice 2 of Patient 075 

The most observable difference between low and high 𝐹𝐹𝑅 cases stems from the location 

and progression of increased regions of velocity magnitude. For most cases of low 𝐹𝐹𝑅, 

regions of red color (high velocity) are confined to discrete spots. Blue/green regions 

(lower velocity) typically surround these spots, leading to proper representations of actual 

stenoses. Patient 019 displays contours of this characterization, where distinct 

(a) (b) 

𝐹𝐹𝑅: 0.97 

(a) (b) 

𝐹𝐹𝑅: 0.81 
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concentrations of increased velocity denote a stenosis and are validated by its plots of 

Scalar0 mean age (FIGURE 4.24) and TABLE 4.2 to cause an increased mean age. 

Contrastingly, instead of having discrete sites of increased velocity, most cases of high 

𝐹𝐹𝑅 exhibit extended lengths of red color throughout a large portion of the slice. This is 

attributed to the artery and its slice narrowing naturally along the length of the geometry 

without the presence of an actual stenosis. Patient 058 exemplifies this behavior, where a 

developed stretch of red color dominates most of both slices, producing no apparent 

increase in mean age. This is substantiated by the Scalar0 mean age plots shown in 

FIGURE 4.28 and the data of TABLE 4.2. From this, it is generalized that contours of 

slices displaying distinct locations of increased velocity as a result of a stenosis typically 

influences and dictates an increased mean age value, while those contours with extended, 

non-stenotic stretches of maximum velocity do not produce an increase in mean age. 

D. Three- and Two-Dimensional Comparison of Mean Age 

The mean age data from the three- and two-dimensional simulations may be 

compared in an attempt to determine a relationship between the two spatial approaches. 

This relationship is sought to determine if reliable results can be obtained that reduces 

computational runtime. Directly, CFD processing of three-dimensional flow is typified by 

considerably lengthier calculation runtimes when compared to those of two-dimensional 

geometries. While three-dimensional calculations often approach a total duration on the 

order of several hours, two-dimensional processing usually lasts on the order of about 60 

minutes, meaning only about 2% of alike runtime is needed. Ultimately, if two-

dimensional slicing can produce a similar mean age metric to its three-dimensional 

source, the more easily-processed, two-dimensional slices may be preferentially chosen 
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to aid in long-term three-dimensional correlative approaches to 𝐹𝐹𝑅. To develop the 

relationship of these spatial approaches, the comparison of the two is efficiently 

presented by plotting mean age as function of 𝐹𝐹𝑅. The data required for plotting, now 

sorting from lowest to highest 𝐹𝐹𝑅 value, are shown in TABLE 4.3: 

TABLE 4.3 

A COMPARISON OF MEAN AGE VALUES FOR THE THREE-DIMENSIONAL 

SOURCE RENDERINGS AND THE TWO-DIMENSIONAL ARTERIAL SLICES 

Patient Number 𝑭𝑭𝑹 
Peak Scalar0 (Mean Age) 

Source 
Rendering Slice 1 Slice 2 

041 0.70 

“low” 

2.9 × 1013 4.8 × 104 4.7 × 10–1 
017 0.72 4.6 × 108 4.0 × 100 1.5 × 100 
005 0.75 2.6 × 105 1.5 × 103 5.1 × 10–1 
004 0.76 1.1 × 105 8.8 × 10–1 8.3 × 10–1 
019 0.76 1.2 × 104 1.6 × 103 2.3 × 101 
075 0.81 

“high” 

8.6 × 103 6.6 × 10–1 2.2 × 104 
045 0.83 7.2 × 10–1 5.3 × 10–1 5.3 × 10–1 
061 0.97 9.0 × 102 1.4 × 100 1.3 × 100 
046 0.98 7.5 × 10–1 2.1 × 100 2.1 × 100 
058 0.98 8.6 × 10–1 7.1 × 10–1 7.4 × 10–1 

As shown in TABLE 4.3, the mean age values of the slices are contained within a smaller 

range in comparison to the source rendering values. Notably, however, TABLE 4.3 

serves to enumerate the difference in magnitudes between three- and two-dimensional 

processing of related cases as a result of an increasing 𝐹𝐹𝑅 value. Cases of high 𝐹𝐹𝑅 are 

typically within one order of magnitude between the source renderings and slices, while, 

in contrast, cases of low 𝐹𝐹𝑅 retain mean age values of the source renderings that are 

many orders of magnitude higher than those of the corresponding slices. The significant 

difference in orders of magnitude between three- and two-dimensional processing of low 

𝐹𝐹𝑅 cases may be attributed to the complexity of the source renderings and the 
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simplicity of the slices. It is believed that important stenotic proceedings onset and 

captured by the complexity of the full three-dimensional source renderings are not 

captured by the simplicity of the two-dimensional slices. This is to say that occurrences 

such as increased red blood cell collisions around a stenosis or an increase in 

recirculatory eddies distal to a stenosis may be less expressed in the two-dimensional 

slice systems. As a result, mean ages between the two spatial approaches are quantified 

by substantial disparity in order of magnitude. 

Setting the value of 𝐹𝐹𝑅 as the ordinate and the value of mean age as the abscissa 

of an ordered pair, the data of TABLE 4.3 may be plotted in order to aid in better 

visualization. It is noted that while data for Slice 2 are present in TABLE 4.3, they are 

shown for completeness and are not used for plotting in subsequent FIGURES. The 

previous subsection established that Slice 2 geometries generally provided no increased 

peak in mean age, so they are withheld from further discussion. Moreover, it is noted that 

source rendering data plotting is performed separately from Slice 1 data plotting. The 

increased magnitudes associated with the source renderings make normalization between 

its data and Slice 1 data largely ineffectual, so two plots of different scale are created 

separately and are shown hereafter 

The plot correlating mean age and 𝐹𝐹𝑅 for the three-dimensional source 

renderings is shown in FIGURE 4.41: 
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FIGURE 4.41 - Quadrant Plot Correlating the Mean Age of Red Blood Cells with 𝐹𝐹𝑅 

for the Three-Dimensional Source Rendering 

FIGURE 4.41 utilizes a vertical line at the previously identified 𝐹𝐹𝑅 threshold value of 

0.80. It is noted that data points to the left of this line dictate cardiological intervention, 

while values to the right of this line dictate no intervention. An analogous line of 

demarcation is needed for the threshold value of mean age. In order to split the plot into 

quadrants, the threshold value of mean age must be determined so as to maximize the 

number of data points in the upper left and bottom right portions of the plot. In doing so, 

the number of patients mean age is able to diagnose accurately will approach that of the 

ability of 𝐹𝐹𝑅. In order to properly determine this threshold value, extensive statistical 

analysis is necessary. In this analysis, traditional and visualization techniques such as 
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ANOVA and regression are used to test a large set of data to find patterns or trends. Since 

the 10 three-dimensional simulation results were previously gathered from a large study 

of 80 patients, the threshold value has been statistically determined, and its value is 2.2 × 

104. As such, a horizontal line is plotted at this value, which is shown in FIGURE 4.41, to 

further demarcate the data and split the plot into quadrants. 

 Quadrants I, II, III, and IV of FIGURE 4.41 represent specific regions of 

importance with regards to mean age and 𝐹𝐹𝑅 as diagnostics. As mentioned previously, 

maximizing the number of data points in Quadrants I and III is desired so as to bring 

mean age in close agreement with 𝐹𝐹𝑅. Data points in Quadrant I accurately predict 

withholding intervention necessity with low mean age and high 𝐹𝐹𝑅 values, while data 

points in Quadrant III accurately predict intervention necessity with high mean age and 

low 𝐹𝐹𝑅 values. In contrast, data points in Quadrants II and IV represent predictive 

errors in diagnosis and are sought to be minimized. Data points in Quadrant II are false 

positives that mistakenly suggest cardiological intervention is necessary, while data 

points in Quadrant IV are false negatives that mistakenly suggest intervention may be 

withheld. The tabulation of these medical statistics concerning FIGURE 4.41 is shown 

subsequently with Slice 1 data in TABLE 4.4. 

The plot correlating mean age and 𝐹𝐹𝑅 for the two-dimensional geometry of 

Slice 1 is shown in FIGURE 4.42: 
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FIGURE 4.42 - Quadrant Plot Correlating the Mean Age of Red Blood Cells with 𝐹𝐹𝑅 

for the Two-Dimensional Geometry of Slice 1 

Similar to the plot for the three-dimensional source renderings, FIGURE 4.42 utilizes a 

vertical line at the previously identified 𝐹𝐹𝑅 threshold value of 0.80. Again, the 

analogous line of demarcation for the correct threshold value of mean age must be 

determined through statistical analysis. Rigorous tests in statistical analysis ultimately 

advance beyond the scope of this investigation due to the limited sample size of two-

dimensional cases, but an estimation of the threshold value is warranted for 

demonstrative purposes. Similar to the quadrant plot for the source renderings, it is 

recognized that the threshold value of mean age must seek to maximize the number of 

data points in the upper left and bottom right portions of the plot. Therefore, as an 
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estimate achieving this goal, the threshold of mean age may be arbitrarily chosen as the 

value of 2.5 × 100. Directly, a horizontal line is plotted at this value, which is shown in 

FIGURE 4.42, to further demarcate the data and split the plot into quadrants. 

 Quadrants I, II, III, and IV of FIGURE 4.42 represent the same medically relevant 

regions described of FIGURE 4.41 previously. As such, the medical statistics of false 

positives and false negatives concerning FIGURES 4.41 and 4.42 are shown in TABLE 

4.4: 

TABLE 4.4 

TABULATION OF THE NUMBER OF OCCURRENCES OF PROPER DIAGNOSIS, 

FALSE POSITIVES, AND FALSE NEGATIVES OBSERVED IN THE QUADRANT 

PLOTS CORRELATING THE MEAN AGE OF RED BLOOD CELLS AND 𝐹𝐹𝑅 

System Occurrences of 
Proper Diagnosis False Positives False Negatives 

Three-Dimensional 
Source Rendering 9 0 1 

Slice 1 9 0 1 

As shown in TABLE 4.4, only one false negative for each spatial approach is present in 

the data when the statistical and arbitrary threshold values of 2.2 × 104 and 2.5 × 100 are 

used for the source renderings and Slice 1, respectively. While limited in sample size, 

false diagnosis is thusly 10% for each system. In literature, virtual approaches to 𝐹𝐹𝑅 

using larger sample sizes have shown false diagnostic values of 10–13% (Papafaklis et 

al., 2014; Tu et al., 2014; Tröbs et al., 2016). In order to maintain the presently 

competing approach that utilizes multiphase mean age theory, its false diagnostic 

percentages should not be greater than those of other virtual 𝐹𝐹𝑅 techniques. For the 

present technique, however, the medical statistics shown in TABLE 4.4 aid in 
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quantifying similarity between the spatial approaches, and the proper statistical 

determination of two-dimensional threshold will rely on this comparison in future 

research developments. It is noted that while both medical statistics represent 

incongruence with the predictions of 𝐹𝐹𝑅, the overdiagnosis of cardiological intervention 

is less problematic than that of underdiagnosing it. 

 With the data of the quadrant plots shown in full, it is again restated that the line 

of demarcation denoting the threshold value of mean age for the two-dimensional data 

was chosen arbitrarily. This value serves as a starting point to demonstrate the feasibility 

of two-dimensional slicing as a surrogate to equivalently processing a three-dimensional 

source rendering. As shown in the previous TABLES and FIGURES, two-dimensional 

slicing bolsters appreciable diagnostic similarity to three-dimensional processing when a 

subjective mean age threshold has been chosen. These results aid in administering the 

preliminary determination of two-dimensional slicing as a meritorious technique 

regarding cardiological context, but at least 80–100 data points are needed to confidently 

support this claim. Ultimately, with more testing and the employment of proper statistical 

analysis efforts, the threshold value of mean age related to the arterial slices may be 

confirmed to strengthen the assertions made of two-dimensional blood flow simulations. 
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V. CONCLUSIONS 

A comparison of stenotic blood flow in two-dimensional arterial slices to flow in 

their three-dimensional source renderings was executed using CFD and multiphase mean 

age theory. Useful in present research attempting to unite angiography with a non-

invasive stenotic evaluator, a relationship between the three- and two-dimensional 

approaches was sought to obtain a comparable method of arterial simulation processing 

that significantly reduces computational runtime. Computer-aided design software 

packages were used to generate two orthogonal arterial slices from DICOM-derived, 

three-dimensional STL files of arteries rendered by coronary angiograms. Following 

mesh generation by the discretization of the domains of the created geometries, CFD 

software was employed to simulate pulsing blood flow in the geometries and to apply 

multiphase mean age theory to calculate the mean age of red blood cells using user-

defined scalars. Results were presented for five patient cases below and five patient cases 

above the commonly accepted 𝐹𝐹𝑅 threshold value of 0.80, below which cardiological 

intervention is prompted for stent placement as a mechanism to avert ischemia.  

In tracking the area-weighted average of mean age of red blood cells, plots of 

mean age throughout the duration of a complete pulse demonstrated peaks with higher 

orders of magnitude for cases with 𝐹𝐹𝑅 less than 0.80. The two-dimensional arterial 

slices typically exhibited this behavior in only the vertically-oriented geometries of Slice 

1. This was ascribed to the limitation of testing only two angles of a 360° arterial 

segment, which more than likely eventuated uncaptured stenotic character from the three-

dimensional renderings within the ineffectual slice. Nevertheless, it was determined that, 
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if sliced at a proper angle, two-dimensional slices are able to distinguish between low and 

high 𝐹𝐹𝑅. 

The increases in mean age for the three-dimensional cases were many orders of 

magnitude higher than those of the corresponding two-dimensional cases. This was 

attributed to phenomena near a stenosis—such as red blood cell collisions or distal 

recirculatory eddies—being less expressed in the simplicity of the two-dimensional 

arterial slices when compared to the complex character of the full three-dimensional 

source renderings.  

Mean age data from the three- and two-dimensional simulations were compared 

using quadrant plots to establish the relationship between the two spatial approaches that 

administers the determination of two-dimensional slicing as a worthy technique regarding 

cardiological context and computational timeliness. Three-dimensional diagnostic ability 

was demonstrated by utilizing a statistically analyzed mean age threshold value of 2.2 × 

104, while an arbitrary threshold value (2.5 × 100) demarcating the diagnostic ability for 

two-dimensional processing was used since limited sample size impeded full statistical 

treatment to obtain it. While not fully statistically grounded, the arbitrary threshold was 

used in an analogous manner to that of the 𝐹𝐹𝑅 threshold value of 0.80 to depict the 

potentiality of slicing as a proxy to equivalently processing a source rendering. As a 

demonstration, this arbitrary value was utilized to indicate the capacity of proper medical 

pronouncement, where the medical statistics of false positives and false negatives were 

largely outweighed by it.  

While three-dimensional calculations often approached a total duration on the 

order of several hours while utilizing parallel computing on 20 processors, two-
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dimensional processing required on the order of about 60 minutes on a single processor, 

which is less than 2% of the required computing power of the three-dimensional cases. 

Preliminary results indicate two-dimensional processing retains compelling calculation 

merit and will be well positioned to efficiently detect and assess stenoses non-invasively, 

provided that it holds up to rigorous statistical analysis. 
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VI. RECOMMENDATIONS 

Foremost, an investment into researching other computer-aided design software 

should be made in an attempt to simplify and ease the process of generating arterial 

slices. As presented in EXPERIMENTAL METHODS, slice generation performed in 

SpaceClaim required a combination of tedious rotating, zooming, panning, and clicking 

of indiscriminate points along the length of the wall of an artery to create splines that 

represented three-dimensional arterial outlines. Researching and testing the capabilities of 

other commercially available software may lead to slice generation that is far more 

expeditious and aids in ensuring orthogonality of geometry is met. With this, as 

mentioned in RESULTS AND DISCUSSION, only two angles out of 360° were created, 

which lent credence to the possibility of stenotic character being uncaptured from the 

three-dimensional rendering. Ideally, in researching other computer-aided design 

software, the ability to revolve a single slice within the boundaries of a three-dimensional 

rendering may be discovered so as to foster swift slice generation and permit the creation 

of all angles automatically. In doing so, the results of blood flow simulation in all of the 

angles may be linked to provide conclusions that more closely mirror the baseline 

outcomes drawn from three-dimensional processing. 

Other recommendations stem from the amount of cases tested, statistical analysis, 

and the meshes used for simulation. Specifically, while 10 cases were analyzed in this 

investigation, more DICOM-derived, three-dimensional STL files of arteries rendered by 

coronary angiograms could be provided for slicing treatment in an attempt to increase the 

repeatability of results, establish better trends, and ultimately further the strength of 

gathered assertions. Directly, testing at least 80–100 additional cases of varying 𝐹𝐹𝑅 
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value—with a concurrent employment of statistical analysis that establishes the proper 

threshold value of mean age—would serve to confidently govern the determination of 

two-dimensional slicing as a worthy cardiological technique when compared to alike 

processing in three-dimensions. Finally, in testing these extra cases, mesh sensitivity 

analysis could be performed as a way to determine whether increasing the element count 

of the discretized domain better resolves the flow field and creates improved mean age 

data.
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APPENDIX I 

SAMPLE SOURCE CODE FOR A UDF FILE 

The following source code represents a UDF file that was used to generate pulsing at the 

boundaries: 

/********************************************************************* */ 
/*                                                             */ 
/* User-Defined Function for Transient Flow in a Channel       */ 
/*                                                             */ 
/* Fluent 6                                                    */ 
/*                                                             */ 
/* Author: Frank Kelecy                                        */ 
/*   Date: January 2001                                        */ 
/*                                                             */ 
/* This function prescribes an oscillating static pressure     */ 
/* at the channel exit.                                        */ 
/*                                                             */ 
/********************************************************************* */ 
 
#include "udf.h" 
 
DEFINE_PROFILE(inlet_velocity,th,i) 
{ 
 
  face_t f; 
 
  double t = (CURRENT_TIME*1.111-floor(CURRENT_TIME*1.111))/1.111; 
 
  begin_f_loop(f, th) 
  { 
   if(t <= 0.42)F_PROFILE(f, th, i) =0.1; else F_PROFILE(f,th,i) = 
0.26*sin(1.58*3.141592654*(t+0.92)); 
  } 
  end_f_loop(f, th) 
 
} 
 
 
DEFINE_PROFILE(outlet_pressure,th,i) 
{ 
 
  face_t f; 
 



 

114 
 

  double t = (CURRENT_TIME*1.111-floor(CURRENT_TIME*1.111))/1.111; 
 
  begin_f_loop(f, th) 
  { 
   if(t <= 0.42)F_PROFILE(f, th, i) 
=0.8*18665.13*sin(1.4*3.141592654*(0.8*t+0.1305)); else F_PROFILE(f,th,i) =(-
13400*t+22700)*0.8; 
  } 
  end_f_loop(f, th) 
 
} 
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APPENDIX II 

PLOTS OF SCALAR1 MEAN AGE 

Fluent was used to simulate pulsing blood flow while tracking a user-defined 

scalar (Scalar1), representing the mean age of plasma, over the duration of flow. Scalar1 

data for the three-dimensional source renderings were not reported, so the following plots 

are for the two-dimensional arterial slices. The five cases of low and five cases of high 

𝐹𝐹𝑅 are shown, respectively, in FIGURES A.1–5 and FIGURES A.6–10: 

   

   

FIGURE A.1 - Area-Weighted Average of Scalar1 for (a) Slice1 and (b) Slice2 of Patient 

004 

   

   

FIGURE A.2 - Area-Weighted Average of Scalar1 for (a) Slice1 and (b) Slice2 of Patient 

005 

0

0.2

0.4

0.6

0.8

0 0.5 1 1.5 2

A
re

a-
W

ei
gh

te
d 

A
ve

ra
ge

 
of

 S
ca

la
r1

Flow Time [s]

0

0.2

0.4

0.6

0.8

0 0.5 1 1.5 2

A
re

a-
W

ei
gh

te
d 

A
ve

ra
ge

 
of

 S
ca

la
r1

Flow Time [s]

0

0.1

0.2

0.3

0.4

0 0.5 1 1.5 2

A
re

a-
W

ei
gh

te
d 

A
ve

ra
ge

 
of

 S
ca

la
r1

Flow Time [s]

0

0.1

0.2

0.3

0.4

0 0.5 1 1.5 2

A
re

a-
W

ei
gh

te
d 

A
ve

ra
ge

 
of

 S
ca

la
r1

Flow Time [s]

(a) (b) 

(a) (b) 



 

116 
 

   

   

FIGURE A.3 - Area-Weighted Average of Scalar1 for (a) Slice1 and (b) Slice2 of Patient 
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FIGURE A.4 - Area-Weighted Average of Scalar1 for (a) Slice1 and (b) Slice2 of Patient 

019 

   

   

FIGURE A.5 - Area-Weighted Average of Scalar1 for (a) Slice1 and (b) Slice2 of Patient 
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FIGURE A.6 - Area-Weighted Average of Scalar1 for (a) Slice1 and (b) Slice2 of Patient 
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FIGURE A.7 - Area-Weighted Average of Scalar1 for (a) Slice1 and (b) Slice2 of Patient 
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FIGURE A.8 - Area-Weighted Average of Scalar1 for (a) Slice1 and (b) Slice2 of Patient 
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FIGURE A.9 - Area-Weighted Average of Scalar1 for (a) Slice1 and (b) Slice2 of Patient 
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FIGURE A.10 - Area-Weighted Average of Scalar1 for (a) Slice1 and (b) Slice2 of 

Patient 075 
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